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Disclaimer

The information in this manual is furnished for informational use only and subject to
change without notice. While every effort has been made to ensure that the information
contained in this user manual is accurate, up-to-date and reliable, EVS Broadcast
Equipment cannot be held responsible for inaccuracies or errors that may appear in this
publication.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this user

manual by e-mail to doc@evs.com.

Regional Contacts

The address and phone number of the EVS headquarters are usually mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at the end
of this user manual (for manuals on hardware products) or at the following page on the
EVS website: http://www.evs.com/contacts.

User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products
can be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New?

The following table describes the sections updated to reflect the new and modified
features on IPDirector from version 6.0 (compared to version 5.9).

In the user manual, the icon @ has been added on left margin to highlight information on
new and updated features.

Click the section number (or the description) in the table to jump directly to the
corresponding section.

Section | Description

Main Window

1.3.7 The Database Explorer now displays edits. Bins can contain edits
as well.

1.3.8 VTR Panel: The Derush mode allows the users to ingest an entire
tape and create a different clip each time a timecode disruption is
encountered.

1.3.9 Possibility to load a timeline on a Control Panel.

1.3.9 Possibility to play a series of clips, a playlist or a timeline with its
transition effects on a single player channel ("Mix on one channel”
functionality).

1.3.13 The Director's Cut application is a new IPDirector module. It
should be fully released by the end of 2012.

23.7-2.3 A Retry Job button has been added to the Transfer Monitoring
window to resubmit jobs with a Cancelled or Error status.

243-244-4 Depending on the server configuration, up to 8 channels can be
displayed on the various panels, with a maximum of 6 recorder or 6
player channels.

Settings

3.1.2 A new setting enable users to perform a search on word
synonyms.

3.1.3 Name Settings for Clips and Files:

* Upto 10 userfields and 5 keywords can be used in
clip/ingest/file auto-names and clip/ingest name prefix.

»  Some format string options result in different values in the final
name or prefix of linked clips recorded on ganged recorders.

3.1.4 General Settings for Clips: new settings related to sub-clipping and
trimming of linked clips.

3.1.6 Settings: OSD settings now apply not only to loaded playlists but
also to other media. So, the OSD Settings window has been
moved to the higher level of the IPDirector Settings window.

What's New? Vi
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Section | Description

Shortcuts

3.24 A new shortcut has been defined to turn the OSD ON or OFF.

System Management

3.3.1 Layouts specifically dedicated to a category of users can be pre-
defined and assigned to a user by system administrators, so it
becomes its default layout.

3.3.2 Layout Management: layout toolbars are no more used with
IPDirector 6.0.

2.3.6-3.4.1-3.4.2 | Edits can now be managed from IPDirector. Metadata can be
-3.4.3 associated to this new item type.

3.54 Two types of layouts can be used with the BEPlay remote.

Two new action buttons are now available to split a playlist
element or to go to an element.

3.54 The BEPlay Remote can be used with timelines.

3.6 ShuttlePRO: two shortcuts have been added: one to turn the OSD
ON or OFF, and one to split a playlist element.

Channel Explorer

423 Updated list of the icons displayed in Channel Explorer.

New icon for player channels supporting the Mix on one channel
functionality.

4.2.5 Player channel name changed on an EVS video server is
immediately reflected everywhere it is displayed in the IPDirector
interface.

4.7 Possibility to turn the OSD ON or OFF from the Channel Explorer.

4.8.2 The option used to display the EVS server configuration window

has been renamed Restart Server.

4.8.3 Possibility to access the EVS Server Web Configuration Tool from
IPDirector.

On-Screen Display

5 New chapter related to the OSD.

Vil What's New?
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1.

1.1.

1.2.

1.2.1.

Introduction

IPDirector Overview

IPDirector is an integrated suite of software applications designed to enhance the
workflow of a television production.

IPDirector uses its applications to control multiple channels from several EVS video
servers connected to the XNet SDTI network. The IPDirector system sees the XNet
network as one large server whose storage is divided into various sections accessible by
any channel from any EVS server within the XNet network.

The IPDirector suite allows:

* ingest control,

* metadata management,

» onthefly editing,

+ playout scheduling,

All are managed from a single interface.

Together with XTAccess, EVS gateway software, media interchange is facilitated
between EVS video servers and third-party tools such as post-production, file-based
camcorders, storage, etc.

IPDirector Uses

Standalone Mode

Each IPDirector workstation can function as a standalone system while providing all
applications for the production, from ingest to playout.

1. Introduction
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1.2.2. Modular Mode

Several workstations can be used, running only the applications required for a specific
task.

Each workstation is connected through Ethemet with a central Database.

When networked together, IPDirector Database information is available to all other
workstations used in different production areas while enhancing the overall production
workflow.
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In this modular mode, the first IPDirector station commands the ingest and is able to
control multiple recordings and the digitization process of tapes into EVS servers.

2 1. Introduction
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1.3.

1.3.1.

This can be complemented with a logging module inside IPDirector which can associate
data with each recording. The logs created will be accessible by all other users on the
different workstations.

Other IPDirector workstations dedicated to the production phase allow a control of media
while making clips, playlists, timelines, bins and logs. They also allow the transfer of
media to third-party editing systems for finalizing edits, for instance.
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|| XS video sarver
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video sarver

XNet SDTI
Nearfine
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Avid Media Composer

Once the edit has been finalized, it can be sent back for playback to an EVS server. At the
end of the production process, another workstation can allow the playback of any clips or
playlists.

It also allows Fill & Key playback with perfect timecode accuracy.

IPDirector Applications

Production Workflow

There are several applications designed for use on a production. Each is integrated into
the overall package and is accessible via installed software licenses.

Each application can be used to perform different tasks.

The following diagram represents the production process and the role of every application.

1. Introduction
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1.3.2. Channel Explorer

The Channel Explorer provides a comprehensive overview of any device available on the
media sharing network, XNet2, including:

+ EVS video servers, with their recorder channels and player channels,
+ XF2removable storage,

+ XStoreSE media storage,

* high resolution and low resolution streams,

* VTR devices,

From within the Channel Explorer window, any IPDirector workstation can take control of
one or several channels from different EVS servers connected to the XNet. When control
has been taken, the selected channels can be locked.

The flexibility of IPDirector allows multiple channels to be managed together in a variety of
methods:

» Ganged channels: allowing simultaneous control of several channels from one control
panel (recorders or players)

» Filland Key: allowing 2 clips to be linked in a Fill/Key pairing for playback to a vision
mixer (switcher) or keyable device.

» Program/preview: allowing the playout of audio and video transition effects between
clips, playlist elements or timeline elements.

* Lock Timeline: allowing two channels to be function as Timeline Engine for use with
IPEdit.

* AB Rall Playlist: to control and play material on up to 4 channels at the same time.

1.3.3. Recorder Panel

The Recorder Panel is the graphic user interface required to control recorder channels of
EVS servers. It displays the channel record status and allows to start or stop the
recording by a recorder channel. It provides the basic functions to create a clip.

4 1. Introduction
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1.3.4.

1.3.5.

1.3.6.

Ingest Scheduler

The Ingest Scheduler is a visual tool that allows the creation, editing and view of
scheduled ingests on EVS video servers, or from the servers to files on storage via
XTAccess. It provides a timeline view of each recorder and stream configured through the
Remote Installer and controlled by IPDirector.

The Ingest Scheduler is designed to control:

* ingests as a growing clip on any recorder channel of an EVS video server (high
resolution or low resolution) controlled by IPDirector.

The scheduled ingests are automatically saved as clip elements of XT Clip type.

» streams of the material ingested onto the recorders. The streams shown are virtual
channels that are automatically associated with each recorder if at least one
XTAccess in the GigE network.

The streams are automatically saved to files and appear in IPDirector as clip elements
of File type.

This module is used to schedule ingests in the future, but can also be used to immediately
start arecording. It is designed to schedule one-shot ingests or to schedule ingests
repeated at regular intervals (Repeat Every ingests) or repeated at a defined start time on
selected days (Repeat ingests).

Ingests can be associated to a logsheet and automatically protected.

IPLogger

IPLogger is used to create logs on a given event. A log is a reference point to a given
timecode in a record train, to which descriptive information can be associated. This is
used to easily identify important moments in an event and create clips later on based on
the logs.

Logs are related to a logsheet which is created for the event and contains its own
metadata, previously defined in a logsheet profile. Users have the possibility to create log
entries directly during the event, or later on.

Users can associate metadata to the log, such as keywords, interest level, highlight color
or a description.

Keyword Management

A set of applications is used to manage the keywords database, prepare grids and
dictionaries for logging, searching and browsing.

Using the Keyword Management tools, a keyword grid or dictionary content can easily be
changed and organized by the operator and production team to make it perfectly suited for
any sport or live production. An unlimited number of keyword grids, consisting of up to 300
words each can be managed by IPDirector.

1. Introduction
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1.3.7.

1.3.8.

1.3.9.

Keyword Management tools allows the addition of single keywords to the database and
therefore to any grid. It also allows the import of keyword grids generated by an EVS
sever, keyword grids from other IPDirector installations and even the integration of
keywords and keyword grids from 39 party databases which may already exist such as
competitor lists and team or event statistical databases.

Simple text files can also be easily imported into the Keyword Database making it easy to
import data from a web page or other document where words exist for your event.

Database Explorer

The Database Explorer is a central point in the IPDirector application to perform search on
all the media available on the network and to load media. It provides access to any high or
low resolution media available on the online production network, as well as nearline
storage platforms. This includes clips (XT clips and files), playlists, edits, timelines, and
logs. It can also display the list of off-line nearline media.

Bins can be created to organize clips, playlists, edits and timelines and bin rules can be
defined to automatically copy clips, playlists, edits or timelines within a bin corresponding
to a specific applied filter.

VTR Control Panel

The purpose of the VTR Control Panel is to control a VTR (Video Tape Recorder) from
IPDirector. It is an advanced remote control, from within the IPDirector application.

Apart from playback and record control, it also allows the extraction of clips from a tape to
the EVS video servers. This process can be done for a single clip or multiple clips can be
"batch digitized".

The VTR Control Panel can be used according 3 modes:

» Transport mode: the VTR Control Panel works as a remote control for the VTR, from
within IPDirector.

» Clip Digitize mode: one or several clips can be digitized from a single tape to a
recorder channel on an EVS video server.

+ Batch Digitize mode: several clips can be queued in a Batch list, so that they can all
be digitized in one process run.

Control Panel

The Control Panel is the graphical user interface used to preview and manipulate:

1. Introduction
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1.3.10.

1.3.11.

1.3.12.

» clips, record trains, playlists and timelines stored on an EVS video server when the
Control Panel is associated to a player channel,

+ files stored on a nearline folder of the GigE network when the Control Panel is
associated to the OCX Software Player (if the workstation has a valid license for it).

It provides transport functions to play the media and clip creation functions to clip media or
trim existing clips.

Clips, playlists or timelines can be played out with transition effects between elements.
To do so, special channel modes must be enabled. Depending on several parameters on
the EVS video server, a single player channel could be used or two player channels must
be dedicated to the playout of the loaded item.

It also allows to:
* build and play clip-lists (simple playlists),
» play back media in loop or bounce-modes,

» synchronize playback on ganged channels.

Playlist Panel

The Playlist Panel allows the creation, modification and playout of multiple playlists on air
using an efficient and extremely flexible workflow.

A variety of playout effects can be defined, different stop or start options can be
programmed, and tags can be set to carry out specific audio or video actions during
playout.

IPEdit

IPEdit allows complete timeline editing while maintaining the speed and power of the EVS
servers recorder and player channels. Drag-and-drop operations and keyboard shortcuts
make it easy to perform video and audio transition effects. Video graphics and voiceovers
can be added to the timelines.

Up to two simultaneous timelines can be created per EVS server. GPI Out allows for
external device automation, and the ability to play out while editing ensures a speed to air
workflow.

AB Roll Playlist

The AB Raoll Playlist application is used to control and play material on a series of
channels from a staged playlist in the database. These channels load in a sequential
manner as per a shows rundown or planned sequence. These channels may be directly
managed using the companion MPlay remote to manage up to 4 player channels.

Playlists from any EVS interface or third party applications, or rundowns from NRCS
(Newsroom Computer Systems) can be used as input for the AB Roll Playlist application.

1. Introduction
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1.3.13. Director's Cut

M The Director's Cut application is used in live or near-live post-productions.

Takes recorded from several camera angles at a time, as well as the Director's PGM cut
which are created with a switcher, are kept on the EVS video servers and streamed or
written to a NLE. An EDL using all the switcher input change notifications that appears on
the switcher when the director produces the show is exported to the NLE in native format

and linked to the takes.

1. Introduction
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2. IPDirector Main Window

2.1. Introduction

The IPDirector main window is the window which opens when IPDirector is started. By
default the IPDirector main window opens without no application window opened.
However, specific layout of windows display may have been assigned to a user or created
and saved by the user, so this layout will automatically be launched when the user logs in.

From this main window, the user can open one or several instances of the various
IPDirector applications.

2.2. Overview of the IPDirector Main Window

The IPDirector main window contains the main areas highlighted on the following
screenshot and shortly described in the table below:

v - X
15-May-2012  16:39:25

2. IPDirector Main Window 9
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Area | Description

1.

Menu bar

The Menu bar gives access to the several menu commands.

* TheFile, View, Windows and Layout menu commands allow
the users to modify and customize the IPDirector user interface in
which they are working.

» The Metadata menu gives access to the options for managing the
customer-defined data that can be associated with clips,
logsheets, playlists and timelines.

+ The Tools menu gives access, among others, to the settings and
shortcuts defined for the various IPDirector applications as well
as some additional options.

* The Help menu gives access to the application version, user
manual, license information, etc.

See section "Menu Bar" on page 11 for more information on the menu

commands.

Application
bar

The application bar provides direct access to the various IPDirector
applications. When the user clicks the icon corresponding to a given
application, the application opens in the workspace.

The Keyword icon gives access to a menu for the selection of the
keyword tool to open.

Each application is widely described in separate chapters of the
current user manual.

Date and
Time fields

These fields are read-only and give information on the date and time
of the SDTI network, if any, or of the EVS video serverin case of a
standalone server.

Workspace

The workspace is the central area used to display the IPDirector
applications that the current user opens. Application windows can be
freely resized and organized in the workspace.

Status bar

The Status bar contains icons and fields that provide information on
the following elements: default player channel, default bin, default
playlist, loaded layout, minimized application windows, messages,
connection status of IPDirector processes and external components,
license validity.

See section "Status Bar" on page 20 for more information on the
elements available from the Status bar.

Channel
Status
panel

The Channel Status panel contains the Recorder Status and the
Player Status tabs. They make it possible to view the recorder and
player channels connected to the XNet network, as well as status
information.

See section "Channel Status Panel" on page 16 for more information
on the Channel Status panel.

Layout
panel

The Layout panel allows single-click access to your saved layouts.
The Layout tab is described in details in "Layout Management" on
page 50.

10
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2.3. Menu Bar

2.3.1. Introduction

File View Windows Layout Metadata Tools Help | FREEZE WORKSPACE Lock Keyboard

The Menu bar gives access to a series of menus and buttons which provides various
commands described hereafter.

2.3.2. File Menu

Clicking the File option on the Menu bar displays the File menu.

Menu Item Description

Log Off User Logs off the current user and displays the Log In window.
Exit Exits IPDirector.

'\ Note

. Priorto log off or exit, it is best practice to save the current layout. The saved
layout will automatically be displayed the next time the user logs on to
IPDirector.

2.3.3. View Menu

Clicking the View option on the Menu bar displays the View menu.

Menu Item Description

Application | Displays or hides the Application bar

Toolbar

Status Displays or hides the Status bar at the bottom of the main window.
Panel

Layout Displays or hides the Layout tab on the left of the main window.

Panel

Green Enables or disables the display of the green messages on the IPDirector

Information | main window when a specific action has been performed, e.g. CLIP
on VGA CREATED, CLIP DELETED....etc.

Message Displays or hides the message boxes. If the option is not selected, no
Box message box will be displayed on the workspace. They will only be
added in the Message field. "Message Panel" on page 22 for information
on the Message field.

2. IPDirector Main Window 11
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2.3.4.

2.3.5.

2.3.6.

Windows Menu

Clicking the Windows option on the Menu bar displays the Windows menu.

Menu Item | Description

Close All Windows Closes all the IPDirector applications opened in the
current session.

<Name of open IPDirector Gives the focus on the application corresponding to the
Application(s)> selected item and brings it to the front.

Layout Menu

Clicking the Layout option on the Menu bar displays the Layout menu.

Menu ltem Description

New Opens the New Layout window to create a new layout.

Open Opens the Load Layout window to select and load an existing layout.

Save Layout Saves the current layout into the database.

Save Current | Saves the current layout with a new name into the database.
Layout as

Delete Deletes an existing layout.
Publish Publishes a layout to a user group.
Properties Displays and allows users to change the layout properties: name,

icon, description, owner, publish options.

Import Imports a layout.

Export Exports one of the existing layouts.

The layout management is described in details in "Layout Management" on page 50.

Metadata Menu

The Metadata menu gives access to the single option Manage Profiles... which opens
the window for defining, importing, exporting and updating the metadata on clips,
logsheets, playlists, timelines and edits.

The Metadata Management is described in details in section "Metadata Profile
Management" on page 57.

12
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2.3.7. Tools Menu

Tools Menu Options

Clicking the Tools option on the Menu bar displays the Tools menu.

Menu ltem Description

Settings Opens the Settings window which gives access to all the categories of
IPDirector settings.

Some categories relate to a dedicated application and are detailed in the
chapter dealing with that application. Other categories are general or
common to several applications and are detailed in "Settings" on page

25,
Logging Opens the Logging Manager window from which users can refresh
Manager associations between logs and clips.

See the IPLogger user manual for more information on that function.

Remote Opens the Remote Control Manager window.
Control When a MPlay Remote device or a BEPlay Remote device is connected
Manager to the IPDirector workstation, you can configure it by selecting the

Remote Control Manager option from the Tools menu. The MPlay
Remote and BEPlay Remote configuration is explained in details in
"Remote Control Management" on page 71.

Recreate all | Allows the creation of thumbnails from a particular EVS video server.
Thumbnails | See section "Recreate All Thumbnails" on page 14.

Define Opens the Define Shortcuts window which gives access to the different
Shortcuts lists of keyboard shortcuts defined for most of the actions possible in
IPDirector.

Some lists relate to a dedicated application and are detailed in the
chapter dealing with that application. Other lists are general or common
to several applications and are detailed in "Shortcut Definition" on page
45,

Transfer Opens the Transfer Monitoring window that provides detailed information
Monitoring | on the clip, playlist or timelines transfers. Transfer monitoring is
explained in section "Transfer Monitoring" on page 14.

Change Allows the currently logged on user to change their password.
Password
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Recreate All Thumbnails

¢\ Note
" . Please note that this function is only available for administrators and should be
used cautiously.

This setting allows the creation of thumbnails from a particular EVS video server when
there is an XML unit set to create thumbnails. Normally this process will function as a
background process. If a system needs to have its clips thumbnails recreated, this
window allows a manual initiation of that process.

Select the XT Serial Number:

XT2_ADL (26410)

Recreate

The Recreate button will send XML files to the XFile or XTAccess on the network that will
create thumbnails for the IPDirector system.

Transfer Monitoring

Purpose

detailed information on the clips, playlists, edits or timelines transfers would they be

M Selecting this menu item will display the Transfer Monitoring window that provides
scheduled, on-going, finished or failed.

Window Overview

The Transfer Monitoring window contains the main areas highlighted on the following
screenshot and shortly described in the table below:
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Transfer monitoring

T Name Start Time

pge_d_120126e-01 FINISHED 26-Jan-2012 11:07:03
00000308 FINISHED 31-Jan-2012 04:18:30
d_pge_120131b FINISHED 31-Jan-2012 04:29:54
d_pge_120131d FINISHED 31-Jan-2012 04:43:50
dip A FINISHED 02-Feb-2012 08:08:20
dip D-01 FINISHED 02-Feb-2012 09:44:30
dipB FINISHED 07-Feb-2012 09:48:17
dipB FINISHED 07-Feb-2012 09:51:10
333333aa FINISHED 08-Feb-2012 10:08:06
PL_pge_120214a ERROR 14-Feb-2012 10:32:04
PL_pge_120214a ERROR 14-Feb-2012 10:34:33

vfi PLAYLIST02 ERROR 14-Feb-2012 10:36:21

Current Transfers Only My transfers Clear History Refresh

Area | Description

1. | Transfer Jobs | Transfer jobs are presented in rows and all their associated

grid parameters and metadata are in columns.

The grid display is managed like other grids in IPDirector. Filters
are available from fields displayed above each column and allow
searches on a specific column of the grid.

2. | Current This option only displays the transfers "In-Progress" and
Transfers Only | "Scheduled" in the grid.
button When the function is enabled, the button background color is
blue.

3. | My Transfers/ | My Transfers: this option only shows the transfers initiated by
All Transfers the logged user.

option list All Transfers: this option shows all the transfers initiated by all

the users. It is only available for administrators / media managers
or users with appropriate user rights.

4. | ClearHistory | Clears the transfers history displayed on the window.
button

5. | Cancel Job Cancels the transfer job for the selected line.
button

6. | Refresh button | Refreshes the list of transfers.

7. | Clear Selected | Clears the line for the selected transfer job from the list.
button
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2.3.8.

2.3.9.

2.3.10.

2.4.

24.1.

Users can resubmit jobs with a Cancelled or Error status by selecting them and clicking
the Retry Job button.

Help Menu

Clicking the Help option on the Menu bar displays the Help menu.

The Help menu gives access to version and license checking features, together with
Monitoring applications for the use of EVS Staff.

Freeze Workspace

Clicking the Freeze Workspace button on the Menu bar locks the IPDirector workspace
to prevent from moving windows, resizing windows or opening a new IPDirector
application.

The button background color turns to blue. The operator can still open the layout shortcut
panel and click a shortcut to change the layout.

FREEZE WORKSPACE

The option is selected again to unfreeze the workspace.

Lock Keyboard

Clicking the Lock Keyboard button on the Menu bar locks the keyboard from use on the
workstation.

The button background color changes to blue as a warning of this action and the
background color of the window title bar turns to red. The control of the workstation is still
possible with a mouse or touch screen.

ﬂ IPDirector - pge

File View Windows Layout Metadata Tools Help = FREEZE WORKSPACE [Lock Keyboard

The keyboard can be unlocked by selecting the option again.

Channel Status Panel

Purpose

The Channel Status panel is made up of the Recorder Status panel and the Player Status
panel. These panels allow the user to monitor the status of requested recorder or player
channels.

By default, the panels are minimized to small REC and PLAY tabs on the bottom left side
of the workspace as shown in the screenshot below.

16

2. IPDirector Main Window



I
IPDirector - Version 6.00 - User Manual - General Workspace — V 5

24.2.

2.43.

Opening and Closing the Channel Status
Panels

To open the Recorder Status panel or Player Status panel for the first time in a session,
proceed as follows:

1. right-click the tab
2. Select the View All Recorders or the View All Players option respectively.

The Recorder tab or the Player tab expands to the right:

02h43m13 B 02h4Sm19 | 05h52m01 B 05h52mi1

| L OFFAIR . OFFAIR |, OFFAR . OFFAIR . OFFAIR . OFFAIR . OFFAIR . OFFAIR

To open the Recorder Status panel or the Player Status panel again during the same
session, simply click the REC or PLAY tab.

To close the Recorder Status panel or Player Status panel, click again on the REC or
PLAY tab.

Recorder Status Panel

Overview of the Recorder Status Panel

43h38m 43h38m 0h0Om 12h04m [2] 21h47m [Z] 21h47m 21h47m 21h47m 21h52m 21h52m 21h52m 21h52m

Depending on the EVS server configurations, up to 6 recorder channels can be displayed
per server.

The Recorder Status panel provides the following information for each recorder channel
displayed on the panel:

* recorder channel name

* remaining capacity on the recorder
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24.4.

* recording status

o capacity information on a red background if the channel is recording

o capacity information on a gray background if the channel is not recording

*+ Lockicon B 21h47m next to the remaining capacity information, if the channel is

locked

« Gang Group icon EllE next to the remaining capacity information, if the channel is
part of a gang group.

Recorder Status Tab Contextual Menu

A contextual menu appears when you right-click the Recorder Status tab.

The following table describes the commands available from the contextual menu.

Menu Item Description

View Recorders | Expands the Recorder Status panel and displays the list of recorder
channels as selected from the Define the Recorder Channels
window.

Add/Remove Allows the user to add recorders to or remove recorders from the

Recorders Recorder panel.

Selecting this item opens the Define the Recorder Channels window
from which you can select the recorders to be added to or removed
from the Recorder Status panel.

View All Expands the Recorder Status panel and displays all recorder

Recorders channels available on the XNet network.

Recorder Channel Contextual Menu

A contextual menu appears when you right-click a recorder area.

The following table describes the commands available from the contextual menu.

Menu ltem Description

Open Recorder
Panel

Opens the Recorder Panel window for the selected channel. See the
Ingest Modules user manual for more information on that window.

Remove

Removes a given recorder from the Recorder Status panel.

Player Status Panel

Overview of the Player Status Panel

ONAR

OFF AR O] ofFFar O] ofFFar OFF AIR OFF AIR OFF AIR OFF AIR

18
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M Depending on the EVS server configurations, up to 6 player channels can be displayed per
server.

The Player Status panel provides the following information for each player channel
displayed on the panel:

* player channel name

* playerstatus

o on airred icon if the player channel is on air

o off air gray icon if the player channel is off air

 Lockicon if the channel is locked

+ Gang Group icon EllE if the channel is part of a gang group or a Fill & Key

association.

Player Status Tab Contextual Menus

A contextual menu appears when you right-click the Player Status panel.

The following table describes the commands available from the contextual menu.

Menu ltem Description

View Players | Expands the Player Status panel and displays the list of player
channels as selected from the Define the Player Channels window.
Add/Remove | Allows the user to add players to or remove players from the Player
Players Status panel.
Selecting this item opens the Define the Player Channels window
from which you can select the players to be added to or removed from
the Player Status panel.
View All Expands the Player Status panel and displays all player channels
Players available on the XNet network.

Player Channel Contextual Menus

A contextual menu appears when you right-click a player area.

The following table describes the commands available from the contextual menu.

Menu ltem Description

Open Control
Panel

Opens a Control Panel window with the selected player channel
assigned to it. See the Control Panel user manual for more information
on that window.

Remove

Removes a given player from the Player Status panel.
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2.5.

Status Bar

Introduction
E* PL_120305a i AUTO_SAVE [# Minimized... 15-May-2012 15:42:49 - Clip Created - d pge 120515a - 652C/02 - 20 00=z& Y

2.5.2.

The Status bar contains icons that provide information on the following elements:
» default channel

» default bin

» default playlist

* loaded layout

* minimized application windows

* messages

» connection status of IPDirector processes and external components

+ license

The Status bar can be hidden from the View menu of the Menu bar.

Default Iltem Icons

Purpose

The default item icons inform whether a default player channel, bin, or playlist has been
defined. If this is the case, the name of the default channel, bin, or playlist will be
displayed.

Default Player Channel

If a default player channel has been defined, the Default Player Channel icon is green
and is followed by the name of the default player channel. A tooltip can be displayed by
moving the mouse over the area.

12 _XTNewPGE_PGM2
» 12 XTNew...

If no default player channel is defined, the Default Player Channel icon is orange and
followed by None.

You can define a default player channel in one of the following ways:

* inthe Channel Explorer, via the Set as Default Player option available from the
contextual menu. See section "How to Define the Default Player for IPDirector" on
page 112.

20
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2.5.3.

» by right-clicking the Default Player Channel field and selecting the default player
channel from the contextual menu.

You can clear the default player channel in one of the following ways:
* by double-clicking the Default Player Channel field.

» by right-clicking the Default Player Channel field and selecting None from the
contextual menu.

Default Bin

If a default bin has been defined, the Default Bin icon is green and is followed by the
name of the default bin.

If no default bin is defined, the Default Bin icon is orange and followed by None.

You can define a default bin in the Database Explorer, via the Set as Default Bin option
available from the Bin contextual menu. See the Database Explorer user manual.

You can clear the default bin by double-clicking the Default Bin field.

Default Playlist

If a default playlist has been defined, the Default Playlist icon is green and is followed by
the name of the default playlist. A tooltip can be displayed by moving the mouse over the
area.

F* PL_1203053

If no default playlist is defined, the Default Playlist icon is orange and followed by None.

You can define a default playlist in the Database Explorer, via the Set as Default Playlist
option available from the Playlist contextual menu. See the Database Explorer user
manual.

You can clear the default playlist by double-clicking the Default Playlist field in the Status
bar.

Loaded Layout Icon

If alayout is currently loaded in IPDirector, the Loaded Layout icon is green and is
followed by the name of the loaded layout.

nw -
m: logging

If no layout is loaded, the Loaded Layout icon is orange and followed by No Layout.

See section "Layout Management" on page 50 for information on how to load a layout.
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2.54.

2.5.5.

You can clear the layout by double-clicking the Loaded Layout field.

Warning
Clearing the current layout will clear the entire user interface of all open windows!
Use this with caution.

Minimized Windows

The Minimized field indicates whether windows have been minimized and allows the
users to restore the minimized windows.

When no window is minimized, the Minimized field has a gray background.

When one or more windows have been minimized, the Minimized field has an orange
background.

To restore a minimized window, click the Minimized field and select the minimized
display of the window you want to restore.

Channel Explorer

A O« - Qe

Control Panel

vy-X
u " E LA v

VX1 PRI - mEan

Database Explorer - Clips

Minimized...

Message Panel

Introduction

The Message field displays the most recent message in the Status bar.

15-May-2012 15:42:49 - Clip Created - d pge 120515a - 652Cf02 -

22
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15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 16:
15-May-2012 15:

15-May-2012 16:15:09

15-May-2012 15:42:49

15-May-2012

39

The Message panel expands by clicking the arrow on the right of the Message field. It
provides a quick display of the information, warning and error messages generated during
the current session.

Clip Created - d pge 120515b - 652D/02
XML Unit (XTAccess_XMLUnt) is not availlable. Transfer cancelled

The XMLUnit (XTAccess_XMLUnit) is not alive

XML Unit (XFile_XMLUnit) is not availlable. Transfer cancelled
The XMLUnit LUnit) is ot alive

XML Unit (XT: MLUNt) is not availlable. Transfer cancelled
The XMLUnit (XTA MLUnit) is not alive

XML Unit (XTAccess_XMLUnit) is not availlable. Transfer cancelled
The XMLUnit (XTAccess_XMLUnit) is not alive

Clip Created - d pge 120515a - 652C/02

Messages Display

The messages include the following information:
+ the date and time when the message was generated
+ the message itself

The messages are highlighted on a different background color depending on the type of
message.

* Aninformation message is highlighted in green.
* A warning message is highlighted in orange.

* Anerror message is highlighted in red.

Message Acknowledgment

As soon as a message appears, the Acknowledge button turns red.

-—>-

Users can acknowledge the message by clicking the button. This changes the
background of the message to gray.

XML Unit (XTAccess_XMLUR) is not availlable. Transfer cancelled

The XMLUnit (XTAccess_XMLUnt) is not alive
Clip Created - d pge 120515a - 652C/02
Bad disk on machine 29830

This helps the user to distinguish the messages that have been dealt with from the ones
that have not.

Messages Filter

Messages can be filtered according to their type thanks to the Message Type buttons
displayed on the top left corner of the expanded Message bar: Information, Warning, Error.

By default, all the filters are enabled and all the buttons have a blue background.
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2.5.6.

2.5.7.

To disable a filter and remove the corresponding messages from the list, users must click
the Message Type button for that filter. The button is then displayed on a gray
background.

Process Status Icons

The background color of the Status icons provides information on the status of the
processes that run in the background:

+  When the background color is green, the process is running or the connection is
established.

*  When the background color is orange, the process is not running or the connection is
not established.

For more information on these processes, refer to the Technical Reference manual.

| Description

Q
o
|

Status icon for the IPDirector Routing process

Status icon for the database connection

Status icon for the SynchroDB process

Status icon for the IPScheduler process

Status icon for the VTR Engine process

Status icon for the EVS video server connection

00000

License Icon

O

The background color of the License icon turns orange when one of the IPDirector
licenses is expiring within two weeks.

24
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3. System Management

3.1.  Settings

3.1.1. Introduction

This section only describes the general and global settings applicable to several modules.
For more information on specific settings, refer to dedicated chapters:

Playlists settings: detailed in the Playlist Panel user manual.

Control Panel settings: detailed in the Control Panel user manual.

Ingest Scheduler settings: detailed in the Ingest Modules user manual.

IPEdit settings: detailed in the IPEdit user manual.

IPLogger settings: detailed in the IPLogger user manual.

Settings are available from the Tools menu of the IPDirector Menu bar.

3.1.2. General Settings

Overview

The General settings apply to the whole IPDirector system.
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IPDirector Settings

General
Autoname
Clip
File
Clips
General
Take
Playlist
General
Colors
Default transition
Audio swap
Macro Commands
Auxiliary Track
Control Panel
Ingest Scheduler
General
Remaining capacity
Advanced
IPEdit
General
Macro Commands
Replace
Edit While Playing
IPLogger
Input GPIs
Output GPIs
0osD
Image Capture

Display XT Structure

Display File Directory Structure

Date Format Recognized in Text
Searches

Freetext search behaviour

Define how to display the XT Directory structure.

Do not display
Display XTs but not Page/Bank
@ Display XTs, Page and Bank

Define how to display the file directory structure.

Do not display directory structure
Display root directory only
@ Display full directory structure

Select the date format recognized when entering a date in text searches (dd/mm/yyyy or mm/ddfyyyy)

dd/mm/yyyy i

Define a way to search on text fields from the freetext search
Classic fulltext v

Select a Way to Copy/Move Elements Define a way to copy/move dips, playlists or timelines.

Confirmation: Display a popup window and ask the operator

Action taken when the Channel is Set Determines what the XT server does when the channel is set to IDLE

to IDLE

Key Default Output Color

Language

No action(leave the video output as it is)

Select the default output color on the key channel when a clip with no assodated key is loaded on the fill
channel.

White

Select the language of the IP Director interface.

English (English) -

Cancel Back to Default

Display XT Structure

The Display XT Structure setting makes it possible to display the server structure in
different ways in the various applications where it is available, e.g. in the Database
Explorer, in the contextual menu of the Control Panel.

Three possible displays are available:

Display option Description

Do not display

All elements are listed without displaying the server structure or
the page and bank organization.

Display XTs but not
Page/Bank

All elements are listed on the level down the server they belong
to.

Display XTs, Page
and Bank

All elements are listed on the level down of the page/bank they
belong to.

26

3. System Management



IPDirector - Version 6.00 - User Manual - General Workspace — / —

Display File Directory Structure

The Display File Directory Structure setting makes it possible to display the file structure
in different ways in the various applications where it is available.

Three possible displays are available:

Display option Description

Do not display All elements are listed without displaying the file directory
Directory Structure | organization.

Display Root All elements are listed on the level down the first level of the file
Directory Only directory structure (e.g. on-line nearline or media files, in the
Database Explorer).

Display Full All elements are listed on the level down of the file directory they
Directory Structure | belong to.

Date Format Recognized in Text Searches

Two formats are available:
* dd/mmlyyyy
* mm/dd/yyyy

Free Text Search Behavior

different manners.

Selected Option Operation Performed

Classic Full Text A search performed with a search string will return the list of
results corresponding to this string. See also the Database
Explorer user manual.

M When the users perform a search based on free text, the system may behave in two

With Thesaurus A search performed with a search string will return the
corresponding synonyms, provided that they have been defined
in the SQL thesaurus file.

Select a Way to Copy/Move Elements

Depending on the selected option, the copy and move operations could be performed in
different ways:
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3.1.3.

Selected Option Operations performed

Windows Style Drag = move
CTRL + drag = copy

Google Style Drag = copy
CTRL + drag = move

Confirmation Style | When dragging a clip, displays a popup window and asks the
operator for the operation to perform.

Action Taken when the Channel is Set to IDLE

Determines what the EVS video server does when the channel is set to idle:
» thevideo output is left as it is (= no action)

+ thevideo output is reset to black

Key Default Output Color

This setting defines the output color on the Key channel when the user loads a Fill clip that
is not associated with a Key clip. The available options are Black and White.

Language

The language setting makes it possible to change the interface language to the selected
language.

Auto-Name Settings

Purpose

The Auto-Name / Clip and Auto-Name / File settings allow the user to define auto-naming
rules for new clips and new files.

28
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IPDirector Settings

General
4 Autoname

Clip
File

Clips
General
Take

Playlist
General
Colors
Default transition
Audio swap
Macro Commands
Auxiliary Track

Control Panel

Ingest Scheduler
General
Remaining capacity
Advanced

IPEdit
General
Macro Commands
Replace
Edit While Playing

IPLogger

Input GPIs

Output GPIs

0sD

Image Capture

Auto-Name Settings for Clips

Clip Name - Format String This string is used to autoname clips when the new ingest/new dip window is not displayed.

Double click an item to insert it in the format string. %COUNTER = Integer counter

%XTNAME = XT Name

%XTNB = XT User Number
%CAM% = Cam

%CAMLBL = Source Name
%TCIN% = Time Code Short In

Clip Name Prefix - Format String This string is used when the new ingest/new clip window is displayed. It acts as a prefix.

Double click an item to insert it in the format string. %COUNTER = Integer counter
%XTNAME = XT Name
%XTNB = XT User Number
%CAM% = Cam
%CAMLBL = Source Name
%K1 = Keyword 1

Clip Name Counter Value Enter the next value of the counter (%COUNTER) in the prefix or autoname format strings.
Pad the value with zeros on the left to determine the number of digits in the counter.
Ex : 0001 means the next value is 0001 and the counter will go from 0001 and loop at 9999.

0001

Cancel Back to Default

Clip Name - Format String

Description

If the Save Clip window or the New Ingest window are not displayed at clip or ingest
creation, the format string defined in the Clip Name - Format String field will be used to
create the clip name or ingest name.

The various possible format string options are listed with a brief explanation under the
field.

Double-clicking an item appends it to the format string.
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User Fields

Up to 10 user fields can be used in the clip name, provided that a metadata profile has
been assigned to the clip and that the selected user field number exist in the profile and
has got a value.

For example, if %UF3 is used in the clip format string, the value entered in the third user
field from the profile will be used in the clip name. This could be text, timecode or date.

Keywords
Up to 5 keywords can be used in the clip name, provided that the corresponding keyword
number has been assigned to the clip.

For example, if %K2 is used in the clip format string, the second keyword assigned to the
clip will be used in the clip name.

Ganged Recorders

When clips are created from ganged recorders, the value used for some of the format
string options in the clip names may be different between linked clips.

These format string options are:

%COUNTER, %XTNAME, %XTNB and % CAMLBL.

For example, clips saved from 3 ganged recorders of a server can be distinguished one
from each other by using the recorder name specific to each linked clip (% CAMLBL) in
their name: CamA, CamB, CamC.

Clip Name Prefix - Format String

If the Save Clip window or the New Ingest window are displayed at clip or ingest creation,
the format string defined in the Clip Name Prefix - Format String field is automatically
added as a prefix to the clip / ingest name.

If this field is left empty, the users will have the possibility to enter a name of their choice
at clip creation.

The possible format string options are the same as for the clip name.
Double-clicking an item appends it to the format string.

The use of format string options related to user fields or keywords or specific to ganged
recorders is the same for prefix as for auto-names.

Clip Name Counter Value

In the Clip Name and Clip Name Prefix format strings, the user has the possibility to insert
an integer counter (% COUNTER). This setting allows the user to view or edit the next
value of the counter, e.g. if 001 is entered in the field, the next counter value will be 001.
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IPDirector Settings

General
4 Autoname

Clip
File

Clips
General
Take

Playlist
General
Colors
Default transition
Audio swap
Macro Commands
Auxiliary Track

Control Panel

Ingest Scheduler
General
Remaining capacity
Advanced

IPEdit
General
Macro Commands
Replace
Edit While Playing

IPLogger

Input GPIs

Output GPIs

0osD

Image Capture

The number of digits entered in the Clip Name Counter Value field defines the format of
the number. For example, if 0001 is entered in the field, the counter will have 4 digits and
the counter will loop from 0001 to 9999.

Auto-Name Settings for Files

Clip File Name - Format String

Stream File Name - Format String

Playlist File Name - Format String

Image File Name - Format String

Format string to use when creating dip files (backup, send to...).
If left empty, the default XTAccess/XFile settings will be used.

Double click an item to insert it in the format string. %NAME = Clip Name

%XTIP = XT IP
%CNB = Clip Number
%CAM% = Cam

Format string to use when creating stream files.
If left empty, the default XTAccess/XFile settings will be used.

Double click an item to insert it in the format string. %NAME = Clip Name

%XTIP = XT IP
%CNB = Clip Number
%CAM% = Cam

Format string to use when creating consolidated playlists.
If left empty, the default XTAccess/XFile settings will be used.

Double click an item to insert it in the format string. %K1 = Keyword 1

%K2 = Keyword 2
%K3 = Keyword 3
%K4 = Keyword 4

Format string to use when capturing image in control panel.
If left empty, the default XTAccess/XFile settings will be used.

Double click an item to insert it in the format string. %NAME = Clip Name

%XTIP = XT IP
%CNB = Clip Number
%CAM% = Cam

Clip File Name - Format String

Back to Default

This setting will be used to name the files created when backing up clips using XFile or
XTAccess. If left empty, the default XTAccess or XFile settings will be used.

The various possible format string options are listed and explained under the field.

Up to 10 user fields can be used in the clip file name. See section "Auto-Name Settings
for Clips" on page 29.

Double-clicking an item appends it to the format string.
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3.1.4.

Stream File Name - Format String

This setting will be used to automatically name files when streaming using XStream or
XTAccess.

The various possible format string options are listed and explained in the field.

Up to 10 user fields can be used in the stream file name. See section "Auto-Name
Settings for Clips" on page 29.

Double-clicking an item appends it to the format string.

Playlist File Name - Format String

This setting will be used to automatically name files created from consolidated playlists
using XFile or XTAccess.

The various possible format string options are listed and explained in the field.

Up to 10 user fields can be used in the playlist file name. See section "Auto-Name
Settings for Clips" on page 29.

Double-clicking an item appends it to the format string.

Image File Name - Format String

This setting will be used to name the files created when capturing an image in Control
Panel.

The various possible format string options are listed and explained in the field.

Up to 10 user fields can be used in the image file name. See section "Auto-Name Settings
for Clips" on page 29.

Double-clicking an item appends it to the format string.

Clips Settings

Purpose

Several settings linked to the clip creation can be defined in the Clips category available
from the Tools > Settings menu. These settings are shortly described below.
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IPDirector Settings

General
4 Autoname

Clip
File

Clips
General
Take

Playlist
General
Colors
Default transition
Audio swap
Macro Commands
Auxiliary Track

Control Panel

Ingest Scheduler
General
Remaining capacity
Advanced

IPEdit
General
Macro Commands
Replace
Edit While Playing

IPLogger

Input GPIs

Output GPIs

0sD

Image Capture

General Settings for Clips

Open Save Clip Window

Guardbands

Default dip Duration

Create Clips on All Synchronized

Recorders

Create sub dips on all ganged clips

Trim all ganged clips

Automatic Clip Creation based on
Logs

Default dip ID Display Mode

Default XT for Partial Clip Restore

¥| If checked, the save dip window is displayed when a new dip is created and the clip will be named.

Guardbands are AfV materials which are added on both sides of the clip boundaries when the clip is 05500
created.

Used to create a clip when one boundary only has been defined

If checked, a dip is automatically created on all ganged channels.

If checked, the system will create sub dips on all ganged dips. If not checked, the system will only create
a sub dip on the selected source clip.

If checked, the system will trim all ganged clips when one dip of the group is trimmed. If not checked, the
system will only trim the selected dip.

Allows for a clip to be created around the timecode of a log when the log is drag'n dropped into a bin.

Pre Mark:  10s00

Post Mark:  10s00

The dip ID mode defines what is the main ID used by the operator in the interface.

Name v

It is possible to create sub clips from clips published on XFiles. Select on which XT by default these sub clips will
be restored

Cancel Back to Default

Open Save Clip Window

If this checkbox is NOT selected, the clip will be made instantly when a new clip is
created in the Control Panel. The clip is stored in the next available location on the page
designated for IPDirector clips in the EVS server setup (default setting is page 6).

If this checkbox is selected, the Save Clip window will open when a new clip is created in
the Control Panel. The user can enter data on the clip in this window. See the Control

Panel user manual.
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Guardbands

The guardbands correspond to A/V material which is added on both sides of the clip
boundaries when the clip is created. They are defined in seconds in this setting field.

When a new clip is saved, the guardbands will automatically be added before the IN point
of the clip and after the OUT point of the clip.

Default Clip Duration

The Default Clip Duration setting makes it possible to create a new clip with the default
duration specified in this setting when only the IN point or the OUT point has been defined
and the NEW CLIP button is clicked.

Create Clips on all Synchronized Recorders
When this setting is selected, clips will automatically be created on all recorders ganged
to the recorder on which the user creates a clip.

The clip that the user has created will have the extension 00 after the name and the clips
created on the ganged recorders will have extension 01, 02, etc. depending on the number
of ganged recorders.

Create Sub Clips on all Ganged Clips
If this setting is selected, when a user creates a sub-clip from one linked clip, sub-clips
will automatically be created from all the clips linked to that clip.

If this setting is not checked, a sub-clip will only be created on the selected clip.

Trim all Ganged Clips
If this setting is selected, when a user trims a linked clip, all the clips linked to that clip will
automatically be trimmed.

If this setting is not checked, only the selected clip will be trimmed.

Automatic Clip Creation based on Logs

A clip can be created when a log is dragged into a bin. The current setting is used to define
the duration between the clip IN point and the log timecode (Pre Mark) and the duration
between the log timecode and the clip OUT point (Post Mark).

Default values for the Pre Mark and Post Mark are 10 sec.

For more information on the creation of automatic clips, refer to the Database Explorer
user manual.
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Default Clip ID Display Mode

The clip ID mode determines which ID will be used by default in the display: Name, UmID
orVarlD.

Default XT for Partial Clip Restore

Clips published from XFile are displayed in the Database Explorer, and can be loaded to a
Control Panel. When the user creates a sub-clip from a file stored in XFile and published,
IPDirector will save the sub-clip on the EVS server specified in the option.

Take Settings

IPDirector Settings

General
4 Autoname

Clip Video 'Mix v
File

Clips
General
Take

Playlist Default Effect Duration Default AfV effect duration used during transitions.
General
Colors
Default transition Audio 00s05
Audio swap
Macro Commands
Auxiliary Track

Control Panel

Ingest Scheduler
General
Remaining capacity
Advanced

IPEdit
General
Macro Commands
Replace
Edit While Playing

IPLogger

Input GPIs

Output GPIs

0osD

Image Capture

Default Effect Type Default AfV effect type used during transitions.

Audio ‘M -

Video 00s05

Cancel Back to Default
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3.1.5.

Default Effect Type

The Default Effect Type setting allows you to define the default transition effect to be
applied when you use the Take function to shift from the PGM to the PRV channel. You
can specify different transition effects for the audio track and the video track.

Default Effect Duration

The Default Effect Duration setting allows you to define the duration of the transition
effect to be applied on the audio track and the video track when you use the Take function.

GPI Settings

Introduction

The GPI is the General Purpose Interface device that can be connected to the EVS video
server. It allows the operator to send commands directly to the EVS server. These
commands need to be reflected in the IPDirector applications.

The GPI keys first need to be configured in the Setup Configuration on the EVS server.
The configuration on the EVS server includes the following settings:

» The definition of the application that will manage the GPI keys. In this case, it would
be IPDirector.

» The port on which the serial connection between the EVS server and IPDirector is
defined.

» The actions assigned to the GPI keys.
The settings which are defined in IPDirector specify the following:

»  Which signal will trigger which action on which player channel of the EVS server when
agiven key is pressed on a GPI device connected to this EVS server. These are the
INPUT GPls. The actions triggered by the GPI need to be reflected in the IPDirector
user interface. The INPUT GPls actions are set up in parallel on the EVS server.

»  Which signal will be transferred by IPDirector via a given GPI key to a third device.
These are the OUTPUT GPlIs.

These settings are defined in the Input GPIs and Output GPIs categories available from
the Tools > Settings menu.

XT Server Selection

In both the Input GPIs and Output GPIs Settings window, the Select an XT Server field
displays all the hi-res EVS servers available on all the network groups.

When an EVS server is selected in the field, the GPI parameters of that server are
displayed. This will allow the user to modify these settings for the selected server.
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Useof TTL GPlIs

Each EVS video server has 4 Input GPls, 4 Output GPls and 4 TTL GPIs which can be
configured either as Input GPls or as Output GPIls. Depending on the option selected in
the How to Use the TTL GPIs field, 4 or 8 GPIs will be displayed.

In the Input GPls Settings window, changing the TTL configuration will result in the
following behaviors:

+ from Input GPIs to Output GPlIs: the configuration of the last 4 Input GPIs is cleared.

+ from Output GPlIs to Input GPIs: a message will warn the user that the TTL GPIls may
be used as Output GPIs in playlist, playlist macro command or timeline macro
command.

In the Output GPIs Settings window, changing the TTL configuration will result in the
following behaviors:

» from Output GPIs to Input GPIs: the configuration of the last 4 Output GPls is cleared.

+ from Input GPIs to Output GPIs: a message will warn the user that the TTL GPls may
be used as Input GPIs in playlist, playlist macro command or timeline macro
command.
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Input GPIs Settings

IPDirector Settings
General
4 Autoname Input GPIs Select the XT server for which you want to configure the input GPIs.
Clip
File
Clips
General
Take Select an XT Server 01_XT2_ADL v Apply to XT
Playlist
General How to Use the TTL GPIs ? The XT Servers have 4 input GPIs, 4 output GPIs and 4 TTL GPIs which can be set as input or output GPIs.
Colors Select how the TTL GPIs should be configured.
Default transition as INPUT GPIs v
Audio swap

For each input GPI, select its trigger mode, the action with its corresponding delay (optional) and on which
channel to perform the action.

Macro Commands Channel Trigger Mode
Auxiliary Track
Control Panel
Ingest Scheduler
General
Remaining capacity
Advanced
IPEdit
General
Macro Commands
Replace
Edit While Playing
IPLogger
Input GPIs
Output GPIs
0sD
Image Capture

Cancel Back to Default

The Input GPIs settings make it possible to configure the action to be triggered on a given
player channel of the EVS server when a given key is pressed on a GPI device connected
to this EVS server.

Up to eight GPI inputs can be used on an EVS server.

For each Input GPI, the following information needs to be defined:
» the action triggered by the GPI key on the EVS server.

» the player channel on which the action needs to be executed.
+ the type of trigger signal sent by the GPI to EVS server.

In the IPDirector workspace, the triggered action will be reflected in the open applications
to which the player channel has been assigned.
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Only the GPI keys set up to be managed by IPDirector on the EVS server can be
configured in the Input GPls Settings window. The other ones will be dimmed.

Warning

The GPIs IN to be used in IPDirector need to be assigned to the IPDP protocol
Setup Configuration module of Multicam (SHIFT-F2, Page 4). Otherwise, they
cannot be defined in IPDirector.

Example

GPYIN Action Channel Trigger Mode

0 03_XT3_PGM1

In the above example, when the GPI key 1 is pressed on the EVS server 03 XT3, this
triggers a playback action on the PGM1 player channel of the XT3 server. The trigger
signal is a rising edge pulse. With the configuration defined above, the IPDirector will
show the triggered action in any application that displays the given player channel.

The following sections describe in details the various fields in the Input GPI Settings
window.

Action

The Action field allows the user to define the action that will be triggered by the GPI key.
The value defined in the Action field for a GPI key is also defined in the Setup
Configuration of the EVS server. Modifying the action type on IPDirector will update the
corresponding value in the EVS server Setup Configuration and vice versa.

The following actions can be defined on a GPI key:

Action Description

PLAY Initiates a play command at 100% on the selected channel.

PAUSE Initiates a pause command on the selected channel.

RECUE Initiates a jump to the IN point of the on air element on the selected
channel.
If this is a playlist, the jump is performed to the IN point of the first clip of
the playlist.

PREVIOUS | Initiates a command to go to the previous clip of a playlist on the selected
channel.

NEXT Initiates a command to go to the next clip of a playlist on the selected
channel.

SKIP Initiates a command to skip the clip being played on the selected
channel.

TALLY Activates or deactivates the on-air flag on the selected channel.
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Action Description

EXITASAP | Initiates a command to exit the loop as soon as possible without playing
the current element until its end and jump to the selected element.

EXITOUT Initiates a command to exit the loop as soon as the OUT point of the
current element is reached and jump to the selected element.

NONE No value is defined.

Channel

The Channel field allows the user to define the channel on which the GPI key action will
be executed. The possible values are:

* achannel of the EVS server to which the GPI is physically linked

* the None value.

Trigger Mode

The Trigger Mode field allows the user to define the type of trigger signal that will be sent
by the GPI to the EVS server. The following trigger modes can be defined:

Trigger Mode Description

Pulse Rising Edge The trigger is done on a rising edge pulse.

.

Pulse Falling Edge The trigger is done on a falling edge pulse.

-

)
3

I High The trigger is done when the level changes to high level.

\_‘

Level Low The trigger is done when the level changes to low level.
-

None No trigger mode is defined.

'\ Note

. If the operator selects None for one of the fields, all three fields are reset to
None. It is considered that the GPI is not used.

Delay

Itis possible to specify a delay between the time the GPI key is pressed and the time the
action will be carried out on the EVS server.
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Output GPIs Settings

Purpose

IPDirector Settings

General
4 Autoname Select the XT server for which you want to configure the output GPIs.

Clip
File
Clips

For each output GPI, select its trigger mode, the action with its coresponding default parameters.

General Select an XT Server 01_XT2_ADL v Apply to XT
Take

Playlist How to Use the TTL GPIs ? The XT Servers have 4 input GPIs, 4 output GPIs and 4 TTL GPIs which can be set as input or output GPIs.
General Select how the TTL GPIs should be configured.

Colors
Default transition
Audio swap
Macro Commands
Auxiliary Track

Control Panel

Ingest Scheduler
General
Remaining capacity
Advanced

IPEdit
General

as INPUT GPIs v

Macro Commands
Replace
Edit While Playing
IPLogger
Input GPIs
Output GPIs
0osD
Image Capture

Cancel Back to Default

The Output GPIs are signals that are sent from an EVS server under the control of the
IPDirector.

The Output GPIs are used to send a signal from the IPDirector to a GPI key at a given
timecode of a playlist played on a given player channel. This signal can then be used to
trigger a record action of the playlist from the given timecode by a third device, for
example a VTR. Up to eight Output GPl commands can be defined.

The Output GPI keys will be unavailable in IPDirector if they have been assigned to the
Remote panel via the Replace function defined on the Remote panel itself.
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For each Output GPI, the output mode, the pulse duration and the offset value can be set
when defining the Output GPI. For more detailed information, refer to the Playlist Panel
user manual.

The Output GPIs Settings window is used to determine how to use the TTL GPIs and to
specify the Advance value.

Advance

In the Advance field, you can specify how many seconds ahead of the timecode (on
which the GPI tag is defined) the Output GPI signal should be sent by the IPDirector.

3.1.6. OSD Settings
Overview

displayed for each playout channel. This does not apply to recorder channels or software

M The On-Screen Display settings allow the users to select the category of information to be
player.
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IPDirector Settings

General

Autoname Select an XT Server 01_XT2_ADL Apply to XT
Clip
File 0OSD Mode XT Channels Global OSD mode 05D info in playlist mode

Clips
General
Take 01_XT2_ADL_PGM2 Detailed

Playlist
General
Colors PGM4 Detailed Display transition information
Default transition
Audio swap
Macro Commands
Auxiliary Track Customize information on the screen

Control Panel

Ingest Scheduler
General In case the OSD Mode is set to "display playlist element”, select which information to display on the screen.

01_XT2_ADL_PGM1 Detailed Display transition information

Display transition information

01_XT2_ADL_PGM3 Detailed Display transition information

Remaining capacity

Advanced R —
IPEdit @ Dipray SSit

Clip Information Display clip name or varlD

General

Macro Commands

Replace

Edit While Playing
IPLogger
Input GPIs Until next unavailable element
Output GPIs
0osD
Image Capture

Display Current On-Air Timecode Display Current On-Air Timecode

Display Remaining Time ® Until next break
Until next transition

In case the OSD Mode is set to "display transition information”, select which information to display on the screen.

Display Remaining Time @ Until next break
Until next unavailable element

Cancel Back to Default

Select an XT Server

In the Select an XT server drop-down list, first select the EVS server for which you want
to specify OSD settings.

OSD Mode

Global OSD Mode

This mode applies to clips, growing clips, trains, playlist elements and timelines loaded on
the channel.
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Basic

With this option selected, only the following information is displayed on screen:
» the current on-air timecode of the clip, growing clip or train loaded on the channel
» the on-air timecode of the playlist element loaded on the channel

» the on-air timeline track position of the loaded timeline.

Detailed

This is the default value.

It gives detailed information about the loaded media.

OSD Info in Playlist Mode

This mode applies to playlists loaded on the player channel.

Display Transition Information

When this mode is chosen, select which type of information to display on screen as
Remaining Time: time until next break or time until next available element.

Display Playlist Elements

The OSD mentions the following information:
* Channel Name

* Previous Clip Name

* Current Clip Name

* Current Clip Name + 1

* Current Clip Name + 2

When this mode is chosen, select which type of information to display on screen as Clip
Information, Current On-Air Timecode and Remaining Time.

Clip Information

This setting defines which clip information will be displayed on screen: the Clip
Name/VarlD or the LSM ID.

Display Current On-Air Timecode

This setting defines whether the current on-air timecode will be displayed or not.
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3.1.7.

3.2.

3.2.1.

Display Remaining Time

This setting defines how the remaining time information will be displayed on screen with
playlists:

remaining time until next break
remaining time until next transition (only with the Display Playlist Elements mode)

remaining time until next unavailable element

Image Capture Settings

Default Path for Captured Images

This setting allows the operators to specify a destination folder where the captured
images will be stored. This path is used for the Grab to File actions.

If the administrator has specified a path applicable to all users in the User Manager,
you will see the path in this setting but you will not be able to modify it.

If the administrator has defined a default path in the User Manager, you can modify the
path if requested.

If the administrator has not defined a default path, you can specify a path for captures
images in this setting. The path needs to point to a shared folder on the Gigabit
Ethernet network and should have the following pattern:
\\<MachineName>\<SharedFolder>\.

Capture Images on all Ganged Recorders or Linked
Clips

When this option is selected, the image grabbed on a clip will also be grabbed:

on all the recorder channels ganged to the recorder channel from which the image is
grabbed.

on all the clips linked to the clip on which the image is grabbed.

Shortcut Definition

Introduction

For each application in the IPDirector there are keyboard shortcuts available to make
operation faster to the operator.

The list of shortcuts can be accessed from Tools > Define Shortcuts.

Some shortcuts can be redefined to suit individual preferences. They are displayed in
regular text. See section "How to Change a Shortcut Setting" on page 46. Other ones
cannot be modified. They appear as dimmed text.
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This section only describes the General and Channel Management Shortcuts, which are
valid for several applications. For more information on shortcuts specific to an application,
refer to:

+ section "Channel Explorer Shortcuts" on page 127

« the Control Panel user manual

+ the Database Explorer user manual

» the IPLogger user manual

» the Playlist Panel user manual

» the Ingest Modules user manual ("Recorder Panel Shortcuts")

» the Ingest Modules user manual ("VTR Control Panel Shortcuts")

» the Ingest Modules user manual ("Ingest Scheduler")

+ the AB Roll Playlist user manual

3.2.2. How to Change a Shortcut Setting

To change a shortcut setting, proceed as follows:

1. Select the menu Tools > Define Shortcut from the IPDirector Menu bar to open the
Define Shortcuts window:

Define Shortcuts

To modify a short-cut, select the corresponding line in the list below and type in the key combination you want to implement from the keyboard

General Description Current Value

Help Shift-F1
Channel Mgmt
Open channel explorer Cri-F1
Channel Explorer Open control panel kR
Open recorder panel Cctrl-F3
Control Panel
Open database explorer ctrl-F4

Database Explorer Open IPLogger Ctrl-F5

IPLogger Open keyword grid Ccri-F6

Open keyword List Ctrl-F7

Playlist Panel
Open dictionary Ctr-F8
Recorder Panel Open Ingest scheduler curtFo

— Open Video display ctr-F10

Open Playlist Panel ctrl-F12
Ingest Schedul
RgESEaCIecITes Open Timeline display Shift-Ctrl-F12
IPEdit Open VTR control panel Shift-Ctrl-F2
Select Next window Ctrl-Tab
AB Roll Playlist
Select Previous window Shift-Ctrl-Tab

Close active window Shift-F4

Back to default values

Cancel

2. Select the application in which you want to modify a shortcut by clicking the
corresponding button on the left. The General and Channel Management buttons
include general shortcuts or shortcuts valid for several applications.

The shortcuts usable in the corresponding application are displayed on the right pane.

3. Select the relevant shortcut action from the shortcut list. Only the shortcuts displayed
in regular text can be modified.

4. Strike the key or key combination to be used as the new shortcut.
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If the new shortcut key is still available, it is automatically modified in the Current
Value column.

If the new shortcut key is not available, the following type of error message is
displayed:

Shortcut already used

Key F1, Control already assigned

to Shortcut Open channel explorer

in the "General” category.

Would you like to swap these 2 shortcuts,

or apply this shortcut anyway and clear Open channel explorer,
or cancel the operation?

Swap Apply and Clear other shortcut Cancel

5. Select OK to confirm the change in the Define Shortcut window.

The change in the shortcut definition are saved and available in the application.

To restore the default values for an application, use the Back to Default Values button in
the bottom right part of the window.

3.2.3. General Shortcuts

All the general shortcuts items that are available are shown in the screenshots below with

their

default values. These shortcuts are global to the system and not specific to one

application. These can be modified and saved by the user if desired.
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Description
Help
Open channel explorer
Open control panel
Open recorder panel
Open database explorer
Open IPLogger
Open keyword grid
Open keyword List
Open dictionary
Open Ingest scheduler
Open Video display
Open Playlist Panel
Open Timeline display
Open VTR control panel
Select Next window
Select Previous window

Close active window

Issue 6.00.B

Current Value
Shift-F1
Ctrl-F1
Ctrl-F2
Ctrl-F3
Ctrl-F4
Ctrl-F5
Ctrl-F6
Ctrl-F7
Ctrl-F8
Ctrl-F9
Ctrl-F10
Ctrl-F12
Shift-Ctrl-F12
Shift-Ctrl-F2
Ctrl-Tab
Shift-Ctrl-Tab

Shift-F4

Description

Select control panel #1
Select control panel #2
Select control panel #3
Select control panel #4
Select control panel #5
Select control panel #6
Select control panel #7
Select control panel #8
Select control panel #9
Select control panel #10
Select keyword grid #1
Select keyword grid #2
Select keyword grid #3
Select keyword grid #4
Select keyword grid #5
Select keyword grid #6

Select keyword grid #7

Current Value

Description
Select keyword grid #8
Select keyword grid #9

Select keyword grid #10

Current Value
Ctrl-8
Ctrl-9

Ctrl-0
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3.2.4. Channel Management Shortcuts

All the Channel Management shortcuts are shown in the screenshots below with their
default values. These can be modified and saved by the user if desired.

Description Current Value

PLAY

Var play

Change the speed of the on-air element
PAUSE

Fast Forward (FF)

Fast Reverse (FR)

E/E

Retumn

Snap to LIVE

TAKE

Activate/Deactivate 2nd controller
Mark IN

Clear IN

Goto IN

Mark OUT

Clear OUT

Goto OUT

Tum OSD ON or OFF

Lock/Unlock channel

Change LOOP mode

Send dip to default bin
Append clip to default playlist
Send to Archive (default Xfile)

Save dip
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3.3.

3.3.1.

Layout Management

Managing Layouts

Context of Use

Depending on job content and personal preferences, most users have a preferred screen
layout (open windows and window positions).

The purpose of the Layout features in IPDirector is to present users their personalized
screen layout every time they log on to IPDirector.

Depending on the user rights, users will be able to create their own layouts by themselves
or a default layout will be assigned to them.

Pre-defined layouts, specifically dedicated to a category of users, are managed in the
User Manager. They can be assigned to a user by system administrators. So, this layout
becomes the default layout for the user.

How to Define Layout

This section describes the way to define a new layout, for users who have the appropriate
user rights.

You can open and arrange the selected windows before creating the layout or you can first
create the layout and arrange the windows later on and save them with the layout name.

To define a layout, proceed as follows:
1. Select New in the Layout menu of the IPDirector Menu bar.

The New Layout window opens.

New Layout

Name
Description

Cancel

50

3. System Management



IPDirector - Version 6.00 - User Manual - General Workspace — / —

2. Enter aname for the layout.

3. If youwant to associate an icon to the layout, click the Select Icon button and select
an icon file from the Open Icon window.

Look jn: |D Layout lcons V| O ¥ R

?Browsing_layout_?BxSZ.ico§
{ filkey_layout_78x32.ico

&

My Recent ganfed_layout_78x32.ico

Documents - Ingest_layout_78x32.ico
= Logging_layout_78x32.ico

L -Playlist_layout_78x32.ico
Desktop Timeline_layout_78x32.ico

\$

My Documents

=

<
O
39{4
b=

<

(1]

File name: { v l I Open |

My Network  Files of type: ’ ico Files (*.ico) v | [ Cancel ]

&

4. Click OK.

The following message is displayed:

Clear Working Area

g Would you like to dear the working area?

5. Click
o Yesif you want to start from a clean working area
or

o Noif youwant to create a new layout based on your current working area.

The Layout name is displayed in the Status bar of the Main window .
6. Incase you have clicked Yes,

a. open and arrange the selected windows.

b. Select Save Layout from the Layout menu.

The current work area is saved with the current Layout name.
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Steps 5 and 6 may be done later on, provided that you first open the layout with the
Layout > Open option.

How to Save a Layout with a New Name

Once you have opened and arranged some windows in the way you want them to appear,
you can save the current layout with a new name. To do so, proceed as follows:

1. Select Save current layout as in the Layout menu.

The Save Current Layout As window appears:

Save Current Layout as

Name logging

Description

Cancel

2. Enter the appropriate information and click OK.

The new Layout name is displayed in the Status bar of the Main window.

Possible Operations on Layouts

Clicking the Layout option from the Layout menu on the Menu bar displays the following

commands.

Column 1 Column 2

New Opens the New Layout window to create a layout. See
section "How to Define Layout" on page 50.

Open Opens the Load Layout window from which you can select
an existing layout. The IPDirector windows associated to
the selected layout will then open on screen.

Save Layout Saves the layout of the open windows with the name of the
currently loaded layout, which is displayed in the Status bar
of the Main window. See section "How to Define Layout" on
page 50.
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Column 1 Column 2

Save Current Layout Opens the Save Current Layout As window to allow you to

as give a name to the current layout. See section "How to Save
a Layout with a New Name" on page 52.

Delete Opens the Delete Layout window from which you can select
the layout(s) to delete.

Publish Opens the Publish window from which you can publish a
layout to selected users.

Properties Opens the Properties window from which you can change
the name and/or the icon of both the layout and the layout
shortcut. You can also publish the layout.

Import Allows to import a layout. The imported layout will be
available from Layout menu.

Export Allows to export a layout as xml file.

3.3.2. Using Layout Shortcuts

Introduction

Shortcuts can be created for the existing layouts, so, a layout can be opened in one-click.

The Layout Shortcuts are defined and selected from the Layout panel.
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¥ 1PDirector - pge

File View Windows Layout |

Channel Explorer u Control Par

New

E=E

logging

¥| Stay visible

The Layout panel opens when you click the Layout
tab on the left screen border.

The procedure for creating a Layout shortcut is
explained in details below.

How to Create a Layout Shortcut

To create a layout shortcut, proceed
1.

as follows:

Click the Layout tab on the left screen border to open the Layout panel.

2. Click the New button from the Layout panel.

The Load Layout window opens:
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Load Layout

Search for:

Name Description Date
DBEX 13-Sep-2012

DBEX RP 13-Sep-2012
DBEX RP VD 13-Sep-2012

empty 17-Jan-2012

:,l.?.ﬂgﬂ_ Vingat S | 16-Jan-2012

BB logging 17-Sep-2012
Logging with Keywords 13-Sep-2012

21 playlist 16-Jan-2012

3. Select an existing layout from the list.
4. Click Load.

The layout is available from the Layout panel:

¥| Stay visible

EEE

logging

a2l

ingest

How to Open an Existing Layout from the Layout
Panel

To open an existing layout by using the Layout shortcut, proceed as follows:

1. Click the Layout tab on the left screen border to open the Layout panel.
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¥| Stay visible

E=E

logging

ka2l

ingest

2. Click the Layout button corresponding to the layout you want to load.

The different windows corresponding to the selected layout open.

Operations on Layout Shortcuts

A contextual menu appears when you right-clicking a Layout Shortcut button in the
Layout panel.

The following table describes the commands available from the contextual menu.

Menu Item Description

Rename

Renames the layout shortcut in the Layout panel but does not rename
the corresponding layout.

Delete

Deletes the layout shortcut but does not delete the corresponding
layout.

Properties

Opens the Properties window from which you can change the name
and/or the icon of both the layout and the layout shortcut. You can also
publish the layout.
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3.4.

3.4.1.

Metadata Profile Management

Metadata, Profiles, User Fields and Automatic
Keywords

Metadata is customer-defined data which can be associated with clips, logsheets,
playlists, timelines and edits.

Metadata Profile

A Metadata profile corresponds to a set of user fields which are managed together.

Thereafter, a profile can be associated with elements such as clips, files, edits, playlists
and timelines, and metadata can be attributed to the element by entering specific values in
the user fields.

After assignment, metadata can be used in searches within the Database Explorer.

A profile can be created in IPDirector or can be imported into IPDirector in the form of an
XML file. The same profile can be used for any element type.

Depending on the user rights defined, the users will be allowed to manage profiles, or to
choose a profile when creating or editing an element, or they will be forced to use to
default profile imposed by the administrator.

Logsheet Profile

Profiles defined for logsheets slightly differ from profiles defined for other elements in that
two profiles can be associated with a logsheet:

» one forthe logsheet user's fields

» one for automatic keywords.

Refer to the chapter on the IPLogger module in the user's manual for a detailed description
of user's fields and automatic keywords.

Profiles for automatic keywords also consist of user fields. Values are entered for these
user fields at creation of logs and will persist through all new log entries made until the
automatic keyword is changed in the Automatic Keywords area of the IPLogger window.
Therefore, they behave as automatic keywords as they will be associated to a log such as
standard keywords, but do not need to be entered for each log separately.

For more information on how to use the metadata and automatic keywords in the
IPDirector applications, refer to:

» the Control Panel user manual

» the Database Explorer user manual

» the Playlist Panel user manual

» the Ingest Modules user manual

» the IPLogger user manual ("Step 1: Defining the Logsheet Characteristics")
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» the IPLogger user manual ("Overview of the IPLogger Window")

» theIPLogger user manual ("Create a New Log Window")

3.4.2. Overview of the Metadata Profiles
Management Window

Introduction

To access the Metadata Profiles Management window, select Manage Profiles from the
Metadata menu of the IPDirector Menu bar.

Manage profiles...

This interface can only be accessed if you have the appropriate user right. It allows you to
create, edit and delete profiles.

Metadata Profiles Management

File Edit

Profiles Logsheet profiles

Search Apply To: Name

Default Name Description = Creation Date
Olympic Games AK 1/12/2012 9:33:54 AM
Olympic Games UF 1/12/2012 9:57:22 AM
Profile1 12/2/2011 12:00:00 AM
Ski Profile 12/2/2011 12:00:00 AM
xma ak 10/5/2011 12:00:00 AM

xma UF 10/5/2011 12:00:00 AM

The window contains two tabs:

» The Profiles tab that lists all the metadata profiles
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» The Logsheet Profiles tab that lists the profiles specifically dedicated to logsheets.

Profiles Tab

Metadata Profiles Management

File Edit

Profiles Logsheet profiles

Search

Default Name Description  Creation Date
Olympic Games AK
Olympic Games UF 1/12/2012 9:57:22 AM
Profile1 12/2{2011 12:00:00 AM
Ski Profile 12/2/2011 12:00:00 AM
xma ak 10/5/2011 12:00:00 AM

xma UF 10/5/2011 12:00:00 AM

This area gives the list of available profiles which can be associated with clips, playlists,
timelines and edits or which can be used when defining a subsequent logsheet profile.

The same profile can be used for any of these element types.

A search operation can be performed either on the profile name, on the profile description
or on both by entering a few letters in the Search field.

A File menu and an Edit menu are available and allow actions such as creation, edit,
import, and export of profiles.

Within the Profiles tab, it is possible to choose a profile as the default profile by selecting
the box next to the chosen profile in the Default column. By doing this, users who do not
have the user right to choose a profile will not be able to select a profile

Logsheet Profiles Tab

Metadata Profiles Management

File

Profiles Logsheet profiles

Define your logsheet profiles by giving them a name, a description and choosing which profile to use for the logsheet User Fields and/or for the Automatic
Keywords.

Search Apply To: Name and description

Default  Name Description Profile for Logsheet User  Profile for Log Metadata = Creation Date

Logsheet 5.9 xma UF xma ak 10/5/2011 12:43:12 PM

logsheet AK <None> xma ak 1/5/2012 4:10:17 PM

Sport - International Olympic Games UF Olympic Games AK 1/12/2012 9:57:32 AM

This area manages the list of available logsheet profiles which can be associated with a
logsheet.

A logsheet profile consists of the selection of a profile for logsheet user fields and/or a
profile for automatic keywords, both created via the Profiles tab.

A search operation can be performed either on the logsheet profile name, on the logsheet
profile description or on both by entering a few letters in the Search field.
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3.4.3.

Within the Logsheet Profiles tab, it is possible to select a logsheet profile as the default
logsheet profile by selecting the box next to the chosen logsheet profile in the Default
column. By doing this, users who do not have the user right to choose a profile will not be
able to select another logsheet profile and the selected logsheet profile and its user fields
will be applied by default to the new logsheets when they are created. Only one metadata
logsheet profile at a time can be defined as the default logsheet profile in IPDirector.

Creating Profiles

Introduction

Creation of profiles and definition of the user fields to be present in each profile will be
done through the Profiles tab. These profiles could then be attributed to clips, playlists,
timelines or edits.

When creating a logsheet profile, in the Logsheet Profiles tab, a profile for logsheet user
fields and/or a profile for automatic keywords are selected from the profiles created via the
Profiles tab and a logsheet profile name is attributed.

How to Create a New Profile

When you create a new metadata profile, you will be able to choose available user fields
from an existing list and/or to define new user fields.

To create a new profile, proceed as follows:

1. Select Metadata > Profiles Management from the IPDirector Menu bar.
The Metadata Profiles Management window opens.

2. Inthe Profiles tab, do one of the following:
> inthe File Menu, select New
OR
o right-click in the profile list and select New from the contextual menu.
The New Profile window opens. "New Profile Window" on page 61.
Enter a profile name and, if required, a description for the profile.

4. If the required user fields already exist, associate them to your profile by selecting
them in the Available User Fields area in one of the following ways:

o by selecting the user field and then clicking the right arrow
o by double-clicking the user field

o by dragging it onto the Selected User Fields area at the position where you want to
drop it.

5. If the required user fields do not already exist, you need to add new user field as
follows:

a. Click the Add New User Field button. The Add New User Field window opens.
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Add a new User Field

Name

Description

b. Fillin the Name field and, if required, the Description field

c. Choose atype for the new user field from the drop-down list. See section "New
Profile Window" on page 61.

d. Click the Save button.
All the selected and/or added user fields are listed in the Selected User Fields area.

6. Re-order the user fields by drag-and drop operation in the way you want them to
appear in the metadata area related to the element.

7. Click Save.

The new profile is created and appears in the Profiles tab of the Metadata Profiles
Management window.

The user fields of each profile will then be listed in the available columns of the Database
Explorer. The column corresponding to a user field could thus be made visible and
searches could be performed on the user field values. The name of the user field appears
as heading of the column in the Database Explorer.

New Profile Window

Context of Use

While creating a new profile, the users have to select the New option in the File menu of
the Profiles tab, in the Metadata Profiles Management window. This will open the New
Profile window. This window makes it possible to enter profile information and to define
the user fields which will appear each time the profile is associated to an element.

A profile is a flat structure: there is no possibility to build trees with user fields under other
user fields.
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Window Overview

New Profile
General

Name

Description

Available

o Filter

Name
combo uf
combo uf
Date

date uf
date uf
Event
EventDate
EventDate

Logger ID

Logging Station

memo uf

memo uf
number uf
number uf
Phase

Sport

Tape Barcode ID
tc uf

tc uf

PN

Type
Predefined Values
Predefined Values
Date

Date

Date

Predefined Values
Predefined Values
Memo

Memo

Number

Number

Number
Predefined Values
Text

TimeCode

TimeCode

Selected User Fields

Type

ected User Field Add new User Field

The New Profile window is divided into three areas shortly described in the table below:
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Area | Description

1. | General area

It contains the Name field and a Description field

2. | Available User
Fields area

It gives the list of the available user fields, and their
corresponding type, which can be selected and associated to a
profile.

It also allows to filter the list through the Filter field or to delete

one or several user field(s) by clicking the Delete Selected User
Field button.

3. | Selected User
Fields area

It gives the list of the user fields selected for the new profile and
their corresponding type. This list is empty when creating a new
profile. During profile creation, items can be re-ordered within the
list by a drag-and-drop operation.

It also enables the users to create new user field and add it to the
profile by clicking the Add New User Field button.

Possible Types of User Fields

When the Add New User Field button is clicked in the New Profile window, the following
types of user fields are available:

User Field Type
Text (64 characters)

Will appear in the element metadata area as...

Free text field

Memo (text, 512
characters)

Free text field

TC (for Timecode)

Timecode field
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User Field Type Will appear in the element metadata area as...

Date Date field with drop-down arrow giving access to a calendar.

dd/mm/yyyy IB

Feb, 2012

112 3 4
5 6 7 8 9 10 11
12 13 14 15 16 17 1B
19 20 21 22 23 24 25
26 27 28 29

Today: 2-Feb-2012

Number Number field with up and down arrows to increase or decrease
the value.

- a
< L

Predefined Text Drop-down list displaying all the values which can be entered
values (64 by the user at creation of the user field (see below).
characters) A "+" sign displayed on the right of the combo box allows you to

add additional values in the list of predefined values.

Equestrian
Sailing
Athletics

Swimmimg
Ice Skating
ki

skiing
cyding

Predefined Text Values (64 characters)

When this type is selected, the expanded Add New User Field window is displayed and
gives the users the choice between two options.
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Add a new User Field

Name

Description

Predefined Text values (64 characters)

@ I want to use the common set of predefined
values

I want to define spedfic predefined values for
my profile

Add

1. Itis recommended to use the common set of predefined values when
o The metadata will be used in only one profile, or

o The metadata will be used in several profiles but the predefined values will always
be the same.

2. ltis recommended to define specific predefined values when

o The metadata will be used in several profiles and the predefined values will differ
depending on the profile.

The users will then have to enter the values they want to be available in the new profile.

How to Define Values for a User Field with Predefined
Values

It is possible to define values for a user field which type is predefined text value
To do so, proceed as follows:

1. inthe New Profile window, click the Add New User Field button and select
Predefined Text Values in the Type field

OR

« inthe New Profile window or in the Edit Profile window, click the Edit button next to
the user field which type is predefined text value

The expanded Add New User Field window is displayed.
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Add a new User Field

Name

Description

Predefined Text values (64 characters)

@ I want to use the common set of predefined
values

I want to define spedific predefined values for
my profile

Add

Cancel

2. Enteravalue in the field above the list of values.

3. Click Add.

The value is listed in the Value list.

If it is a common set of predefined values:

» the new value will be added to the edited profile and
+ all profiles containing this user field are updated

If it is a specific set of predefined values:

+ the new value will only be added to the edited profile.

How to Create a Logsheet Profile

To create a logsheet profile, proceed as follows:
1. Inthe Logsheet Profiles tab, do one of the following:
o inthe File Menu, select New
OR
o right-click the logsheet profile list and select New from the contextual menu.

A new line appears in the list. It is highlighted and the cursor is placed in the Name
field to allow the user to enter a name for the logsheet profile.

2. Entera profile name and, if needed, a description for the profile.
3. Click at the right of the cell in the Profile for Logsheet User Fields column.

An arrow appears.
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3.4.4.

Click the arrow to display the list of available profiles.

Select a profile to be used as Logsheet User Fields profile.

Click at the right of the cell in the Profile for Automatic Keywords column.
An arrow appears.

Click the arrow to display the list of available profiles.

Select a profile to be used as Automatic Keywords profile.

Editing Profile and User Fields

Possible Actions

Once created, it is still possible to edit a profile. The profile name or the profile description
can be modified. User fields can be added, removed, updated or re-ordered by a drag-and
drop operation.

How to Remove a Selected User Field from a Profile

To remove a user field from a profile, proceed as follows:

In the Profiles tab, select the profile to be edited.

2. Select the Edit option in the File Menu or in the Profiles contextual menu.

The Edit Profile window opens, which is similar to the New Profile window.
Do one of the following:

o double-click the user field to be removed

o selectitinthe Selected User Fields area and click the left arrow

o dragit onto the Available User Fields area.

If some elements already reference the profile, a warming message is displayed.

Remove a User Field from the profile X

Some elements already use this profile. Suppressing fields will result
o in a loss of data. It will not be possible to retrieve this data once the

field is removed.
Are you sure you want to remove these fields from the profile ?

Answering Yes will remove the fields from the profile and all previously entered data
for that profile will be cleared from the user fields table.

If no elements reference the profile, the fields are removed from the profile without
warning message.

3. System Management 67



EVS Broadcast Equipment S.A. - November 2012 Issue 6.00.B

3.4.5.

How to Edit a Profile or a User Field

If you want to edit the information related to each user field (name, description or type),
proceed as follows:

1. Inthe Profiles tab, select the profile you want to edit.

2. Do one of the following:

o

o

In the File menu, select Edit.

Right-click the profile line and select Edit from the contextual menu.

The Edit Profile window, similar to the Add New Profile window, opens.

Make the desired changes: add, remove, move user fields or rename the profile.

To edit a user field (name, description or type):

a.

b.

C.

In the Selected User Fields area of the New Profile window, click the Edit button
at the right of the user field you want to edit.

The Edit a User Field window similar to the Add New User Field window will then
opens.

Make the desired change (name, description or type).
Click Save.

The user field is updated.

Warning - Adding a User Field to an Existing Profile

If a user field is added to an existing profile, it is added to the corresponding
metadata profile associated to existing elements and the user field will have an
empty value.

Deleting User Field or Profile

How to Delete an Available User Field

The user can delete a user field from the list of available user fields either from the New
Profile window or from the Edit Profile window. To do so, proceed as follows:

1. Inthe Available User Fields list, select the user field to be deleted.
2. Click the Delete selected User Field button.

o

If no element references the user field and if the user field is not present in another
profile, the user field is then deleted.

If the user field is present in a bin rule, a warning message is displayed.
If some elements already reference the user field or

If the user field is present in the Selected User Fields list of another profile, even if
it is not referenced, a warning message is displayed.
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X

User Field 'Event’ is already in the following profiles: Ski Profile. Some
elements already reference these Profiles.

Suppressing this field will result in a loss of data. It will not be
possible to retrieve this data once the field is deleted

Are you sure you want to delete this User Field permanently ?

Click Yes.

The user field is deleted from the Available User Fields list and will no longer be available.

How to Delete a Profile

You can choose to permanently delete a profile or mark a profile as deleted. To do so,
proceed as follows:

1. Inthe Profiles tab, select the profile to be deleted.
2. Do one of the following:
o Inthe Edit menu, select Delete
o Right-click the profile and select Delete from the contextual menu.

In case the profile is referenced, an error message is displayed:

-

x The profile xma ak is selected in at least one logsheet profile, you
cannot deleted it or mark it as deleted.

In case the profile is not referenced, it remains present in the Metadata Profiles
Management window, in a dimmed and italic format, but it is no more accessible. It could
nevertheless be recovered later.

& Note

. A profile marked as deleted can be recovered by
» selecting the profile and then selecting Undelete In the Edit menu,
OR
* right-clicking the profile and selecting Undelete from the contextual menu.
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3.4.6.

3.4.7.

How to Delete a Logsheet Profile

To delete a logsheet profile, proceed as follows:

1. Inthe Logsheet Profiles tab, select the logsheet profile to be deleted.
2. Right-click the logsheet profile

3. Select Delete from the contextual menu.

The logsheet profile is deleted from the list.

If a logsheet profile is used in a logsheet that has at least one log, it cannot be deleted.

Copying a Profile
You can choose to copy an existing profile and then edit some information if needed. To
copy a profile, proceed as follows:
1. Select the profile to be copied.
2. Do one of the following:
o Inthe Edit menu, select Copy
OR
o Right-click the profile and select Copy from the contextual menu.
The Enter New Profile Name window is displayed.
3. Enter the new profile name and click OK.

The new profile is created with the same description and user fields as the original one.

Importing and Exporting Profiles

How to Import a Profile or a Logsheet Profile

To import a metadata profile, proceed as follows:
1. Select the profile or the logsheet profile to import.
2. Inthe File Menu, select Import Profiles.
The Import Profiles window opens.
Select the . XML file that contains the metadata profile to import.

Select the file type:

o XML files
o Legacy XML files for IPDirector versions 4.4 and previous.
5. Click Open.

The profile is imported in IPDirector and it appears in the list of profiles of the Metadata
Profiles Management window.
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3.5.

3.5.1.

How to Export a Profile or a Logsheet Profile

To export a metadata profile into an XML file, proceed as follows:
1. Select the profile or the logsheet profile to export.
2. Inthe File Menu, select Export Selected Profiles.

The Export Profile window opens:

Export Proﬂiles

Save in: I JD My Documents j ﬁ‘ '
L3 [Z1IPD Photo
3 uﬂ My Music
My Recent  |(Z)my Pictures
Documents |2 Snaglt Catalog
VT () visual Studio 2005
|2 PLOO1 _pge.xml
Desktop % PLOD1 _pge_exp.xml
- || pl_120124a_exp.xml
J || Profile BrowserProfile. xml
|| Profile MediamanagerProfile. xml
ML Do |2 User administrator,xml
— |2 User John.xml
‘\%! = User Mark.xml
My Computer | User Peter.,xml
“ =
My Network  File name: I LI B
Places
Save as type: IXmI Files LI Cancel

3. Select the folder where you will export the file in the Save in field and type a file name
for the profile to export in the File Name field.

4. Click Save.

The profile or the logsheet profile is exported to the requested folder.

L Note
« Toexport the default profile, select Export Current Profiles from the File menu.

Remote Control Management

Introduction

Remote devices can be connected to IPDirector to perform specific actions.

The MPlay Remote is a Multi-Playout controller used to control the playout of subjects on
up to 4 channels.

The BEPIlay Remote is used for media browsing, editing and playout.
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3.5.2.

3.5.3.

Opening the Control Manager Window

The configuration of the remote devices is performed through the Remote Control
Manager window. It can be accessed from the IPDirector main window, via Tools >
Remote Control Manager.

The window displayed several tabs, one for each remote device assigned to a serial
communication port in the Remote Installer.

MPlay Remote

Introduction

The MPlay Remote is a simple interface dedicated to control the playout of clips, playlists
or graphics. It is designed to simultaneously control up to 4 player channels. Its buttons
can be configured to perform classic transport functions.

MPlay Remote Configuration

Overview of the Remote Control Manager Window

You can access the Remote Control Manager window from the IPDirector main window,
via Tools > Remote Control Manager.
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Remote Control Manager

AVH-RS422-3 BE Play

No Channel

Linked channels:

Previous

-

Connection status:  Connected

No Channel

-

MODE: MASTER

-

¥ Apply function to all channels

No Channel

Linked channels:

-

Identify

Then, select the tab corresponding to the MPlay Remote device.

Several MPlay remote devices can be connected. In this case, as many tabs are
displayed as they are devices. One of the devices is defined as Master, the other ones as
slaves. This is done in the Remote Installer. Refer to the Technical Reference manual.

You will be able to control up to four player channels with one device.
Assigning Player Channels

How to Assign Player Channels from the Channel Name Contextual
Menu

To assign a player channel to the MPlay Remote from the Channel Name field of the
Remote Control Manager window, proceed as follows:

1. Inthe Remote Control Manager window, right-click one of the Channel Name field. A
contextual menu is displayed:
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No Channel
None

XTOIdADL

XT2_PGE

XTNewPGE | 12 XTNewPGE PGM1
XTNewADL 12 XTNewPGE_PGM2
12_XTNewPGE_PGM3
12_XTNewPGE_PGM4

2. Select aplayer channel.
3. Repeat steps 1 and 2 for all the channels you want to associate to the buttons.

The channel name is displayed in the Channel Name field.

How to Assign Player or Recorder Channels to Function Buttons from
the Channel Explorer

To assign player channels to the MPlay Remote by a drag-and-drop operation from the
Channel Explorer, proceed as follows:
1. Open the Channel Explorer.

2. Select the player channel and drag it to one of the fourChannel Name field areas in
the Remote Control Manager window.

No Channel

Linked channels:

The player channel name is displayed in the Channel Name field:

01_xt3 1_PGM2

Linked channels:

3. If needed, repeat these two steps for the three other Channel Name field areas.
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In case the player channel is linked to another one in a PGM/PRV mode, gang mode or Fill
and Key mode, the linked channels are listed in the Linked Channels field:

Linked Channels

In case the channel is linked to another one in a PGM/PRV mode, gang mode or Fill and
Key mode, the linked channels are listed in the Linked Channels box.

+  PGM/PRV Mode:

01_xt3 1_PGM1

Linked channels:

01_xt3 1_PGM2

* Gang Mode:

01_xt3 1_PGM1

Linked channels:

01_xt3 1 PGM2

» Filland Key Mode:

01_xt3 1_PGM1

Linked channels:

01_xt3 1_PGM2

How to Customize Transport Buttons

To associate a transport function to one of the button, proceed as follows:

1. In the Remote Control Manager window, right-click one of the buttons in the box you
have assigned a player channel to.

The contextual menu with all the transport functions available is displayed:
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Previous

2. Select the function you want to assign to the button.

The action name is displayed in the button for the selected channel:

Reset to default
MNone

Play

Pause

Previous

Mext

Skip

Goto In

Goto Out

Recue

Preview Transition
Fast Forward
Fast Rewind
Return

Snap

E/E

Loop

On Air

Play Yar

\ Note

. Ifthe Apply function to all channels checkbox had previously been selected,
when the operator assigns a function to a button, it is assigned to all the
corresponding buttons for the player channels controlled by the remote. This
maodification is done on the selected tab only, not on all the connected MPlay

devices.

How to Use the MPlay Remote

When you have assigned a player channel to the MPlay Remote and configured its

buttons, you can use the device to perform actions on that channel.

1. Associate the same player channel to an IPDirector module such as Control Panel,
Playlist Panel, Database Explorer or AB Roll Playlist interface. You can assign it to

several windows at the same time.
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3.54.

2. Onthe MPlay Remote, press the button corresponding to the action you want to
apply.

The action is performed on the panel or window which is active at the moment you press

the button.

BEPlay Remote

Introduction

The BEPIay remote is a remote controller for browsing, editing and playing content.

It can be configured to control selected channels and to send media to predefined
destinations.

The first sections of the current chapter are dedicated to the configuration and the
description of the various buttons.

The next sections provide procedures on the main functionalities which can be performed
with the remote.

Overview of the BEPlay Remote Buttons

The BEPIay remote device has different kinds of buttons. They are represented on the
following image and shortly described in the table below.
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DDBEBBBDDD

[IP] Controller

Area | Description

1. | Function Buttons | Function buttons are used to control a recorder or a player
channel, or the Software Player.

2. | Special Buttons | 4 buttons can be used with specific actions or together with
other buttons.

3. | Action Buttons 14 buttons can all be used to perform two different actions,
depending on whether the SHIFT button is pressed prior to the
button. The actions vary according to the selected layout.

4. | Wheel Mode Three buttons are available to select the mode according to

Buttons which the wheel will be used.

5. | Wheel The wheel is used to navigate through the loaded media. It can

be used according to 5 different modes.

See section "BEPlay Remote Buttons" on page 82.
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BEPIlay Remote Configuration

Overview of the Remote Control Manager Window

The configuration of the BEPlay remote device is performed from the Remote Control
Manager window.

You can access this window from the IPDirector main window, via Tools > Remote
Control Manager. Then, select the tab corresponding to the BEPlay Remote device.
There can only be one BEPIlay remote per IPDirector workstation.

The remote configuration is linked to the workstation, not to the user.

Remote Control Manager

BE Play on USB1

F1 F2 F3 F4 F5 F6

O | O | [ 3|

02_XT2_PGE_REC1 02_XT2_PGE_PGM1 @ [1] 02_XT2_PGE_REC2 02_XT2_PGE_PGM2 02_XT2_PGE_PGM3 ¥ Software Player

Linked channels: Linked channels: Linked channels: Linked channels: Linked channels: Linked channels:
02_XT2_PGE_PGM3 @O 02 xT2_PGE PGML & [1]

Drag'n drop a recorder on each function button or an XT anywhere on the tab. A channel or the software player can also be associated by right dicking on the channel name. When open in the interface, the software player car
be associated to the BE Play by pressing the assigned favourites key or just pressing SHIFT+F1.

Choose a layout Destination

Choose one or more destination that will be associated to the send to button.
LayoutWithGrab

E* Default Playlist (PL pge 120514a)
= Target
Monitoring @ Clean Edit
Connection status :  Connected Link : RS 422 [ XTs
v Default Archive

Bins

From this window, you will be able to

» assign channels to the remote Function buttons

+ select aremote layout

» define target destinations to send the controlled media to

* monitor the connection status.

Monitoring the Connection Status

The connection status is monitored from the Monitoring area.

The remote can be connected through a RS422 port or a USB port. The RS422 port must
be configured in the Remote Installer.
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When a serial port has been configured, the Link: RS422 is displayed in the Monitoring
area and the system looks for a BEPlay remote on the serial port.

If no serial port has been configured, the system tries to detect a BEPlay remote on a
USB port. If one is found, Connected — Link: USB is displayed in the Monitoring area.

Selecting a Remote Layout

Choose a layout

LayoutWithGrab

LayoutWithGrab
LayoutWithSplit

Only clips, playlists and timelines can be controlled by the device.

Two modes are defined for using the BEPIay. So, two layouts are available from the
Choose a Layout field. The two layouts differ in two action buttons.

» The Layout with Split : will be preferably used with playlist elements
» The Layout with Grab

Clicking on the View button opens the Layout Form window which corresponds to the
selected layout and shows the name of the functions assigned to each button. No action
can be performed from this window.

All the functions linked to each button are described in "BEPlay Remote Buttons" on page
82.

The following screenshot shows the Layout Form window for the Layout with Grab
layout.
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DDBBBEEBDD
[ij E]

[IP] Controller

Assigning Channels to Function Buttons

See section "Assigning Channels to Function Buttons" on page 89.

Selecting Destination Targets

From the Destinations area of the Remote Control Manager window, users define the
destination targets where the media will be sent to when using the Send to button.

The available destination targets are the following:

the user's default bin, if any
the default playlist, if any
a default archive target

any target destination visible on the GigE network that has been defined in the
Remote Installer (CleanEdit targets, Avid targets, Final Cut Pro targets, File targets,
XT targets).

the EVS servers for which the user has visibility right

the bins configured in IPDirector and for which the user has write access right.
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BEPIlay Remote Buttons

Function Buttons

Function buttons are used to control a recorder or a player channel, or the Software
Player. The section "Assigning Channels to Function Buttons" on page 89 describes the
possible ways to assign channels to function buttons.

The LED of a function button gives indication on the channel assignment.

The LED of a

Function button... ——

is green a player channel or the Software Player is assigned to the button

flashes green the player channel or the Software Player assigned to the button is
being controlled by the Remote

is red a recorder channel is assigned to the button

flashes red the record train from the recorder channel assigned to the button is

loaded on the player controlled by the Remote

is not turned on * nochannel is assigned to the button, or
» the user cannot see the recorder channel or control the player
channel, or

» the Software Player is not opened.

Action Buttons

The BEPIlay Remote has 14 buttons which can all be used to perform specific actions.
M Those actions will depend on several conditions:

» the SHIFT key is pressed before the button or not

» the Layout selected from the Remote Control Manager window

» the mediatype (clip, playlist, train, playlist element or timeline) loaded on the channel
controlled by the remote.

The following table gives a brief description of the action of each action button. The media
types on which the action button has an effect are mentioned in bold in the Description
column.
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Button Description

RECUE Playlists:
Preloads the first frame of the first playlist element from the playlist
associated to the controlled channel.
Timelines:
Acts as Goto Mark IN in the IPEdit Player.
Acts as Recue timeline in the IPEdit Timeline.
SHIFT, Displays alist and allows
SELXT |. toselectthe EVS server from which the channels will be assigned to
the Function buttons in Normal mode. See section "Assigning
Channels to Function Buttons" on page 89.
OR
* toassociate the Software Player to the remote. The Software Player
option is displayed in the list only when the Software Player is
associated to a Control Panel or a Playlist Panel.
MENU: gets out of the list.

BROWSE | Enables or disables the Browse mode. The button is red in Browse mode.
See section "Browsing Media with the BEPlay Remote" on page 96.

SHIFT, Playlists:

:;Sg; * Ifthe Ioadeq playlis.t glgment is not in a partial loop, the Loop Elem

button puts it in an infinite loop.

» If the loaded playlist element is the single element in a partial loop, the
Loop Elem button removes the loop.

» If the on-air playlist element is in a partial loop containing other clips,
the Loop Elem button has no effect.

SEARCH | Clips / trains:

U Displays the list of clips and trains containing the same TC as the loaded
clip and allows the selection of an element by using the wheel.

The selected element is automatically loaded on the same frame as the
initial element.

MENU: gets out of the list.

ENTER: appends the loaded clip to the default playlist.

SHIFT - ENTER: inserts the loaded clip to the default playlist before or
after the on-air element.

SHIFT, Displays the list of last created clips and allows the selection of a clip by

LAST using the wheel,

CLIPS Automatically loads the last created clip on the controlled channel. Then,
by moving the wheel through the list, the clip highlighted in the list is
automatically loaded on the controlled player.

MENU: gets out of the Last Created Clips list.

ENTER: appends the selected clip to the default playlist.

SHIFT - ENTER: inserts the selected clip to the default playlist before or
after the on-air element.
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Button Description

SEND TO | Sends the media to the destinations predefined in the Remote Control

Manager window.

Playlists: sends the loaded playlist.

Clips: sends the loaded clip or the marked portion of the loaded clip.
Trains: sends the marked portion of the loaded train.

See section "BEPlay Remote Configuration" on page 79.

SHIFT, When channels have previously been ganged, this function ungangs, or re-

GANG gangs channels.

SHIFT, Playlists:

GO TO Exits a partial loop and jumps on the selected element, according to the

ELEM selected Exit Loop mode, i.e. as soon as possible or when the OUT point
of the current element is reached.

SPLIT Playlists Elements:

Splits the loaded playlist element in two elements at the current timecode.

GRAB Playlists / clips / trains:

Saves a small image of the loaded media for use as a thumbnail. The
image will be that of the current position when you click the Grab button.
The image is stored as afile in a directory specified in the Settings (Tools
> Settings > Image Capture > Default Path for Captured Images).
See section "Image Capture Settings" to know how this path can be set.
SHIFT, Displays a menu with the list of available recorder channels.
SEL REC | MENU: gets out of the list.
See section "Loading Media" on page 94.
PLAY Playlists / clips / trains / timelines:
Plays the media loaded on the controlled channel.

SHIFT, Playlists / clips / trains:

PLAY Plays the media loaded on the controlled channel at speed defined in the

VAR Control Panel settings.

PAUSE Playlists / clips / trains / timelines:

Stops the playout of the media loaded on the controlled channel.

SHIFT, Playlists / clips / trains:

SNAP Goes back to the last loaded record train or recording ingest at the
timecode where the E/E mode was exited, effectively "snapping" back to
where the user left off in the record train or recording ingest.

This function can be used with clips loaded on the IPEdit Player.

PREV Playlists / clips / trains:

Loads the previous playlist element, linked clip or train on the controlled
channel.
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Button Description

SHIFT, Playlists:

PRV Allows the user to preview a transition effect between playlist elements.
TRANS | This starts the play before the element transition, for the duration of the pre-
roll defined in the Playlist Panel.

NEXT Playlists / clips / trains:

Loads the next playlist element, linked clip or train on the controlled
channel.

SHIFT, Playlists:

SKIP Skips the next playlist element when playing a playlist. If the button is
pressed twice, the next 2 elements will be skipped, and so on.

E/E Playlists / clips / trains:

Unloads the loaded media and loads the last loaded record train or
recording ingest at its current recording position.

This function can be used with clips loaded on the IPEdit Player.

SHIFT, | Clips:

RETURN | When a clip has been loaded on a player channel, pressing RETURN loads
the same frame of media from the original record train, if it is still available
(not overwritten in the recorder yet).

This function can be used with clips loaded on the IPEdit Player.

IN Playlist elements / clips / trains:
Inserts a Mark IN point at the current position of the loaded media.

CLEAR, | Playlist elements/ clips / trains:
IN Clears the Mark IN point which has been set but not yet saved.

Goto IN Playlist elements / clips / timelines:

Goes to the IN point of the loaded media.

This function can be used with clips loaded on the IPEdit Player or with
timelines from the IPEdit timeline pane.

ouT Playlist elements / clips / trains:
Inserts a Mark OUT point at the current position of the loaded media.

CLEAR, Playlist elements / clips / trains:

ouT Clears the Mark OUT point which has been set but not yet saved.
Goto Playlist elements / clips / timelines:
ouT

Goes to the OUT point of the loaded media.

This function can be used with clips loaded on the IPEdit Player or with
timelines from the IPEdit timeline pane.

NEW Playlist elements / clips / trains:

Allows the user to save a new clip after Mark IN and Mark OUT points
have been defined.

This function can be used with clips loaded on the IPEdit Player.
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Button Description

UPDATE

Playlist elements / clips:
Allows the user to save the changes made to a playlist element or to a clip.

TAKE

Playlists / clips / trains:

If the controlled channel is in PGM/PRYV mode, the Take function shifts
from the current media on the PGM channel to the media on the associated
PRV channel using the Take Effect settings as defined in Tools >
Settings > Clips > Clips/Take.

If the controlled channel is in Lock Timeline mode, the Take function acts
as atoggle between the media on the Player pane and the media on the
Timeline pane using the Take Effect settings as defined in Tools >
Settings > Clips > Clips/Take.

LOOP
CHNL

Changes the loop mode of the controlled channel.

Playlists: no loop < loop (green action button).

E .
Clips: no loop < loop (green action button) < loop bounce

(red action button).

Special Buttons

The BEPIlay Remote has 4 buttons which can be used with specific actions or together
with other buttons.

The following table gives a brief description of the action of each button.
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Button Description

MENU |- "Escape": When using the Sel XT, Last clips, Search TC or Sel Rec
options, a list is displayed on the IPDirector screen.

The MENU button gets out of the list.
*  When using MENU — wait for 3s - ENTER: locks / unlocks the remote.

SHIFT | The SHIFT button is used prior to another button to modify the behavior of

this button:
+ SHIFT, action button: allows to apply the action associated to the upper
part of the button.

» SHIFT, ENTER: from a list (Last clips, Search TC or Browse options)
inserts the loaded clip to the default playlist, before or after the loaded
element, depending on the setting.

» SHIFT, MENU button: switches the function buttons assignment
between the normal mode (all channels of an EVS video server) and the
favorite mode (channels defined in the Remote Control Manager window).

The MENU LED flashes red in favorite mode.

« SHIFT, VAR button and SHIFT, JOG button: see section "Wheel Mode
Buttons" on page 87.

» SHIFT, F1 button: used to associate the Software Player to the remote.

CLEAR | The CLEAR button is used prior to another button to modify the behavior of
this button. When it is activated, its LED is red.

e CLEAR, IN: works as CLEAR IN
« CLEAR, OUT: works as CLEAR OUT

*+ CLEAR, ENTER: cancels the applied saved filter in the Database
Explorer.

ENTER | The ENTER button can be used alone (see below) or together with other
buttons (refer to the description of the other buttons).

* InBrowse mode, in the Last Created Clips list and in the Searchon TC
list, when a clip is loaded on the controlled channel, pressing the ENTER
button appends it to the default playlist.

* Inthe SEL XT and the SEL REC lists: pressing the ENTER button
confirms the selection.

* Inthe Database Explorer tree view: opens or closes a tree node.

* Inthe saved filter pane of the Database Explorer: applies the selected
saved filter.

Wheel Mode Buttons

Three buttons are available to select the mode according to which the wheel will be used.
As some of these buttons can be used in association with other buttons, a totality of 5
wheel modes are available to the users.

Pressing a Mode button activates a wheel mode but does not change the playout speed.
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VAR Mode
The Var wheel mode enables to move in the loaded media at a selected constant review
speed. It is activated by pressing the VAR button. The LED is red.

The zero position is calculated from the current playout speed to correspond to the point
where the speed is null. The following picture represents the positions of different speed
values:

0%

-100% 100%
-300% 300%

Shift Var Mode

The Shift Var wheel mode is used to fine tune a speed by applying +1% or -1% to the
speed. It is activated by pressing the SHIFT key then the VAR button. The LED flashes
red.

The current speed corresponds to the zero position. The speed can be increased
(clockwise), or decreased (counter-clockwise). The positions of the different speed values
will differ according to the initial playout speed.

Shuttle Mode

The Shuttle wheel mode enables to play fast forward or fast rewind the loaded media. It is
activated by pressing the SHUTTLE button. The LED is red.

The speed range is: -35x to +35x.

Jog Mode

The Jog wheel mode is used to navigate through the loaded media field by field. It is
activated by pressing the JOG button. The LED is red.

One impulsion of the wheel corresponds to a jump of one field and is equivalent to
pressing the left arrow or the right arrow keys on the keyboard.

Fast Jog Mode

The Fast Jog wheel mode is used to navigate through content. It is activated by pressing
the SHIFT then the JOG buttons. The LED flashes red.

One impulsion of the wheel corresponds to a jump of 1 second.
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Assigning Channels to Function Buttons

Assignment Modes

Each of the 6 Function buttons can be assigned to a recorder channel, to a player channel
or to the Software Player.

The assignment of channels to Function buttons can be done in two ways:

» Favorite Mode: selected channels are defined in the Remote Control Manager
window. This is done during the configuration of the remote.

« Normal mode: this mode uses all channels of an EVS video server. The server can be
selected from the remote, during its use.

To switch the function buttons assignment between the normal mode and the favorite
mode, press the SHIFT key and then the MENU button.

Assigning Player or Recorder Channels to Function
Buttons in Favorite Mode

How to Assign Player or Recorder Channels to Function Buttons from
the Channel Name Contextual Menu

To assign a recorder channel, a player channel or the Software Player to a Function
button of the BEPlay Remote from the Channel Name field of the Remote Control
Manager window, proceed as follows:

1. Inthe Remote Control Manager window, right-click one of the Channel Name field. A
contextual menu is displayed:

No Channel
None

Software Player

XT2_ADL

XT2_PGE 02_XT2_PGE_REC1

02_XT2_PGE_REC2
02_XT2_PGE_PGM1
02_XT2_PGE_PGM2
02_XT2_PGE_PGM3
PGM4

2. Select a channel or the Software Player.
3. Repeat steps 1 and 2 for all the channels you want to associate to the buttons.

The channel name is displayed in the Channel Name field:
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02_XT2_PGE_REC1

02_XT2_PGE_PGM1

Software Player

and the Function button LED turns red (recorder) or green (player) in the Remote Control
Manager and on the remote:

(-]

How to Assign Player or Recorder Channels to Function Buttons from
the Channel Explorer

[l

To assign a recorder channel or a player channel to a Function button of the BEPlay
Remote by a drag-and-drop operation from the Channel Explorer, proceed as follows:

1. Open the Channel Explorer.
2. Select the channel and drag it to one of the six Function button/ Channel Name field
areas in the Remote Control Manager window.

No Channel

Linked channels:

The channel name is displayed in the Channel Name field:

02_XT2_PGE_REC1 02_XT2_PGE_PGM1

and the Function button LED turns red (recorder) or green (player) in the Remote
Control Manager and on the remote:

'\ Note

>\ If you do not have the user right to control the channel, the channel name is
displayed but the Function button LED is dimmed.

3. If needed, repeat step 2 for the other Function buttons.
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Linked Channels

In case the channel is linked to another one in a PGM/PRV mode, gang mode or Fill and
Key mode, the linked channels are listed in the Linked Channels box.

+  PGM/PRV Mode

02_XT2_PGE_PGM1

Linked channels:

02_XT2_PGE_PGM2 PRV

+ GangMode

02_XT2_PGE_REC1 @ [1]

Linked channels:
02_XT2_PGE_REC2 @

* Filland Key Mode

02_XT2_PGE_PGM1

Linked channels:

02_XT2_PGE_PGM2

How to Un-Assign Player or Recorder Channels to Function Buttons
To un-assign a player or recorder channel from a Function button, proceed in one of the
following ways:

* Right-click the Channel Name field and select None

e Double-click the Channel Name field.

Assigning EVS Server Channels to Function Buttons in
Normal Mode

To assign all the channels from an EVS video server to the Function buttons of the
BEPIay Remote, proceed as follows:

1. Onthe remote, press the SHIFT key and then the Sel XT button.

The list with the available EVS video servers is displayed on screen.
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2. Use the remote wheel to move through the list of EVS servers.
3. Press the ENTER button of the remote to select one of the EVS servers.
Note: To cancel the operation: press MENU.

The server recorder channels are assigned to the first Function buttons and the
corresponding LED are red. The server player channels are assigned to the next buttons
and the corresponding LED are green.

In case the EVS server has less than 6 channels, the exceeding buttons are not assigned.

When it has more than 6 channels, recorder channels are assigned first and the player
channels are assigned until no more Function button is available.

Selecting a Player to Control

A player channel or the Software Player can be controlled by the remote.

Selecting a Player Channel to Control

To select one of the player channels, press the Function button which has been
associated to it in Favorite mode or in Normal mode, as described in section "Assigning
Channels to Function Buttons" on page 89.

The LED of the Function button flashes green.

If the player channel is already associated to a Control Panel or a Playlist Panel, the
BEPIay remote icon appears in the Player field of this panel:

g © 02 XT2_PGE_PGM3

Itis also displayed in the Channel Explorer, next to the controlled player.

In Timeline mode, two players are associated to form the Timeline Engine. They can be
PGM1/PGM2 or PGM3/PGM4. Pressing the Function button assigned to the odd player
gives access to the IPEdit Timeline pane. Pressing the Function button assigned to the
even player gives access to the IPEdit Player pane.
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Controlling the Software Player

Favorite Mode

If you work with the player and recorders which have been selected in the Remote Control
Manager window, you can take the control of the Software Player with the BEPlay remote
in one of the following ways:

* Press the Function button which has been assigned the Software Player in the
Remote Control Manager window.

+ Press SHIFT, F1 on the Remote, would the Software Player be associated to a
Function button or not.

Normal Mode

If you have assigned all the channels of an EVS server to Function buttons from the Sel
XT function, you can take the control of the Software Player with the BEPlay remote in
one of the following ways. In both cases, the Software Player must have previously been
associated to an open Control Panel or Playlist Panel.

* Press SHIFT, F1 on the Remote.
* Press SHIFT, SEL XT on the Remote, as explained below.
1. Onthe remote, press the SHIFT key and then the SEL XT button.

The list with the available EVS video servers and the Software Player is displayed on
screen.

2. Use the remote wheel to select the Software Player.
3. Press the ENTER button of the remote.
Note: To cancel the operation: press MENU.

The Remote icon appears on the left of the Player field in the Control Panel or Playlist
Panel:

)

) Software Player
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Loading Media

Loading a Train

Possible Actions

Users can load a train on the controlled player channel in one of the following ways:

N

If the required recorder is assigned to a Function button, press this Function button.
The LED flashes red.

In case atrain is already loaded on the controlled player, you can press the NEXT or
the PREV button to load the train from the next or the previous recorder.

To select a recorder channel not assigned to a Function button, proceed as follows:
Press the SHIFT key and then the SEL REC button.

The list with the available recorder channels is displayed on screen.

01_XT2_ADL_REC2

02_XT2_PGE_REC1
02_XT2_PGE_REC2

Use the remote wheel to move through the recorder channels list.
Press the ENTER button of the remote to select a recorder.

Note: To cancel the operation: press MENU.

The train is loaded on the player channel or on the Software Player controlled by the
remote.

Rules for Loading a Train

Depending on the element previously loaded on the controlled player channel, the
behavior will vary as follows:

Element Previously Loaded | Pressing the F button of a recorder...

Playlist loads the corresponding train in E/E.

Clip loads the corresponding train in E/E.

Train in Pause loads the corresponding train in pause at the same
timecode.

Train in Play loads the corresponding train in play at the same
timecode.

Trainin E/E loads the corresponding train in E/E.
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Loading a Clip

Possible Sources of Clips

Clips can be selected from different sources to load them on the controlled player channel:

From the Search TC list: see section "BEPlay Remote Buttons" on page 82.
From the Last Created Clips list: see section "BEPlay Remote Buttons" on page 82.

From the Database Explorer grid: see section "Browsing Media with the BEPlay
Remote" on page 96.

How to Load a Linked Clip

1.

Select the player to be controlled by the BEPIlay remote, as described in "Selecting a
Player to Control" on page 92.

Press SHIFT, Last Clips on the BEPlay.

The Last Clips window is displayed on screen and the last created clip is loaded on
the controlled player.

Use the wheel to move through the list until the requested clip is highlighted.

The highlighted clip is automatically loaded on the controlled player.

Last dlips

d pge 120514d 651E/02
d pge 120514c 651D/02
d pge 120514b 651C/02
d pge 120514a 651B/02
PM LS Cup 2012-01 651A/02
PM LS Cup 2012-00 650F/02
tennis04 650E/02
swimming01 650D/02
tennis03 650C/02

Press MENU to get out of the list.
Press Search TC on the BEPIay.

The Search TC window opens on screen and displays the list of clips linked to the
loaded clip.

Search TC
PM LS Cup 2012-00 650F/02 650F/02

PM LS Cup 2012-01 651A/02 651A/02

6. Use the wheel to move through the list until the requested clip is highlighted.

The highlighted clip is automatically loaded on the controlled player.
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Browsing Media with the BEPlay Remote

The BEPIay remote allows the users to browse
* elements within a playlist,

+ clips from the Database Explorer, would they be in the Clips plug-in or in the
Bins/Clips plug-in.

Browsing a Playlist

Prerequisites

To be able to browse a playlist with the remote, some conditions must be met:
* aplayerchannel or the Software player must be controlled by the remote
» the playlist must be opened in a playlist panel or in a control panel

» the player channel controlled by the remote must be assigned to the playlist panel or
the control panel where the playlist is opened.

How to Browse a Playlist

To browse a playlist when the prerequisites are met, proceed as follows:
1. Press the BROWSE button on the remote.

The panel on which the playlist is opened becomes active on screen.
2. Usethe wheel to select a playlist element:

e inclockwise to select the next element

o inacounter-clockwise to select the previous element.

The selected element is cued on its IN point.
Browsing Clips

Prerequisites

To be able to browse a clip with the remote, some conditions must be met:
» aplayerchannel or the Software player must be controlled by the remote

» the player channel or Software player controlled by the remote must be assigned to
the Database Explorer

» the remote must be linked to the Database Explorer by double-clicking the BEPlay
Remote area on the status bar of the Database Explorer.
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Moving through the Database Explorer

The users can navigate in the grid, in the tree view or in the saved filters pane if it is
displayed. To move from one pane of the Database Explorer to another, use the following
remote buttons:

+ NEXT: move from grid — saved filters, if the pane is displayed — tree view

* PREV: move from grid — tree view — saved filters, if the pane is displayed.

€ Note

N

« The active pane is not highlighted. When you turn the remote wheel, you will see
in which pane the selection is moving.

How to Browse a Clip in the Grid

To browse clips when the prerequisites are met, proceed as follows:
1. Press the BROWSE button on the remote.

The Database Explorer linked to the remote becomes active on screen.

The Browse mode of the Database Explorer is enabled
The focus is on the grid.
2. Usethe wheel to select a clip:
o inclockwise to select the next clip
° inacounter-clockwise to select the previous clip.
The selected clip is cued onits IN point on the controlled player.
3. Tosend the loaded clip the default playlist, do one of the following:
o Press the ENTER button to append the current clip to the default playlist.

o Press SHIFT then ENTER to insert the current clip to the default playlist before
or after the on-air element, according to the settings.

To send the clip to the predefined destination:
o Press the SEND TO button.

How to Browse a Clip in the Tree View

To browse clips when the prerequisites are met, proceed as follows:
1. Press the BROWSE button on the remote.

The Database Explorer linked to the remote becomes active on screen.

The Browse mode of the Database Explorer is activated
The focus is on the grid.

2. Usethe PREV button to move to the tree view.
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3.6.

3.6.1.

3.6.2.

3. Inthe tree view, only the Clips plug-in and the Bins/Clips plug-in can be browsed. Use
the wheel to move from one plug-in to the other.

4. Press the ENTER button to open or close a tree node.
The corresponding list of clips is displayed in the grid.

5. Press the NEXT button to be able to browse the list.

How to Browse a Clip in the Saved Filters

To browse clips when the prerequisites are met, proceed as follows:
1. Press the BROWSE button on the remote.

The Database Explorer linked to the remote becomes active on screen.

The Browse mode of the Database Explorer is activated

The focus is in the grid

Press the NEXT button to move to the saved filters, if the pane is displayed.
Use the wheel to select afilter.

Press the ENTER button to apply afilter.

Press the PREV button to move to the grid and browse clips.

To cancel the filter, press the CLEAR button then the ENTER button.

o o~ 0 N

ShuttlePRO Configuration

Introduction

ShuttlePRO has a Jog wheel, a Shuttle ring, and fifteen buttons. The two top rows of
buttons on the ShuttlePRO have labels for quick reference as to which function each
button is designed to perform.

Since version 4 of IPDirector, the ShuttlePRO driver is no more needed. IPDirector
accesses directly to this device. The button configuration is now hard coded.

Button Configuration

The controller has different functions depending on which mode the IPDirector is being
operated in. The long buttons on the lower part of the controller have a different function at
either end. Other buttons have CTRL or SHIFT from the keyboard as a modifier to
change the button function. These functions are shown in red for CTRL and blue for
SHIFT in the diagrams below.

Details on the button functions are included in the different chapters of the IPDirector
manual. The diagrams below are quick reference guides to the location of the functions.
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3.6.3. Quick Reference in Clip Mode

ﬁ In clip mode, the ShuttlePRO buttons can be used for the following operations:

| |
Previous Train / Clip ‘ Next Train / Clip
Previous Char b Fast Rewind ext Cl
Previous Panel Next Panel
Selec! ‘F"Iay“(’er: ] ‘ Select Train
Pause Fast Forward
Pia_y E/E
IN ouT
Clear IN Clear OUT
Gang / Ungang Sync
Save
Fast Jog Qu e
’ Update
~ Shuttle
Click
: .“ &8 & 1CF
SHIFT + Click
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3.6.4. Qui

ck Reference in Playlist Mode

ﬁ In playlist mode, the ShuttlePRO buttons can be used for the following operations:

Previous Clip (Edit)
Pre Pla
Previous Panel

Select Player

Pause

Play

Trim IN (Edit)

Clear Guardband IN

Gang / Ungang

Fast Jog

Fast Rewind

Shuttle

Click
I ick

SHIFT + Click

Next Clip (Edit/Play)
Next Pl

Next Panel

Select Train

Fast Forward

EE

Trim OUT
. T (E
Clear Guardband OUT

Sync

Append
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3.6.5. How to Control a Player with the ShuttlePRO

To control a player channel or the Software Player with the Shuttle PRO, proceed as
follows:

1. Press the Select Player key on the ShuttlePRO controller.

This calls up alist of players available to be controlled.

Select Player

01_XT2_ADL_PGM1
01_XT2_ADL_PGM2
01_XT2_ADL_PGM3
PGM4

02_XT2_PGE_PGM1

02_XT2_PGE_PGM2
02_XT2_PGE_PGM3
PGM4
None

2. Usethe jog dial to move through the list and highlight the required player channel or
Software Player.

3. Press the Select Player key again to assign the channel and exit the menu.
See section "ShuttlePRO Configuration" on page 98 for more information on the controller.

The ShuttlePRO icon appears next to the channel that is now linked to the controller.

» 02_XT2_PGE_PGM1 @
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4.

4.1.

Channel Explorer

Introduction

The Channel Explorer provides an overview of:

logical XNet networks as defined in the Remote Installer, tagged as high resolution or
low resolution

EVS servers with their channel configurations (inputs and outputs). Depending on the
server configuration, up to 8 channels can be displayed, with a maximum of 6 recorder
or 6 player channels.

o streams appear directly under the recorders as a relative path

o low resolution recorders appear under the associated high resolution recorders,
after the streams

XFile (for XF) and XStore devices on the XNet network

VTRs being controlled by an IPDirector workstation

102

4. Channel Explorer



— =
IPDirector - Version 6.00 - User Manual - General Workspace — / —

Channel Explorer

EW Orec v | Player
4 [* 12_XTNewPGE
» |®| 12 XTNewPGE_REC1
» |®| 12 XTNewPGE_REC2
4 |®| 12_XTNewPGE_REC3 (CE_growing02)
Stream Hi (CE_growing02)

4 |*| 12 XTNewPGE_REC4

L

Stream Hi
|| 01_xt3 1_PGM1 (12_XTNewPGE_PGM1) rcm
|»| 01_xt3 1_PGM2 (12_XTNewPGE_PGM2) prv
|»| 01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
|»| 01_xt3 1_PGM4 (12_XTNewPGE_PGM4)

p =7 02_XT2_PGE
4 [x7] 16_XTNewADL
» |®| 16_XTNewADL REC1
» |®| 16_XTNewADL_REC2
» |®| 16 _XTNewADL_REC3
» |®| 16_XTNewADL_REC4
[»| @ II] 02_xt3 2_PGM1 (16_XTNewADL_PGM1)
|| @ [I] 02_xt3 2_PGM2 (16_XTNewADL_PGM2)
| »| 02_xt3 2_PGM3 (16_XTNewADL_PGM3)
|| 02_xt3 2_PGM4 (16_XTNewADL_PGM4)
» & 01_XTOMADL
~ XFile

Through the Channel Explorer, any IPDirector workstation can take control of one or
several channels on EVS servers that are connected to the XNet network.

You can perform many operations from the Channel Explorer module, for example:
* lock channels from use by others

» start or stop aningest

* gang multiple channels

» create specialized playback modes.

Indeed, the flexibility of IPDirector allows multiple channels to be managed togetherin a
variety of methods:

» Ganged channels: allowing simultaneous control of several channels from one control
panel (recorders or players)

» Filland Key: allowing 2 clips to be linked in a Fill/Key pairing for playback to a vision
mixer (switcher) or keyable device.

*  Program/preview: allowing the playout of audio and video transition effects between
clips, playlist elements or timeline elements.
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4.2.

421.

42.2.

4.2.3.

Lock Timeline: allowing two channels to be function as Timeline Engine for use with
IPEdit.

AB Roll Playlist: to control and play material on up to 4 channels at the same time.

User Interface

Opening of Channel Explorer

To open the Channel Explorer, click the icon on the Application bar
of the main window.

Channel Explorer Views

Several views are available in the Channel Explorer:

Tree view
Rec view
Player view
VTR view

XFile view

These views are explained below.

The Tree view is displayed by default when Channel Explorer opens.

Tree View

Overview of the Tree View

Click the Tree button to activate the Tree view:
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Channel Explorer

B3 ree

Orec v B Player

» % 01_XTOMADL
4 [ 02_XT2_PGE

’

-

3 LL'-IJ
~

L J

L’J

02_XT2_PGE_REC1
02_XT2_PGE_REC2
02_XT2_PGE_PGM1
02_XT2_PGE_PGM2

4 =7 12_XTNewPGE

> |

»

A

»

>
Reilnd

>

L

>
-4

L

s
el

-
el

P
e ad

s
el

L}_J

12_XTNewPGE_REC1
Stream Hi
12_XTNewPGE_REC2
12_XTNewPGE_REC3
Stream Hi
12_XTNewPGE_REC4
01_xt3 1_PGM1 (12_XTNewPGE_PGM1) rcm
01_xt3 1_PGM2 (12_XTNewPGE_PGM2) - Default prv
F [1‘ 01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
K El 01_xt3 1_PGM4 (12_XTNewPGE_PGM4)

4 %71 16_XTNewADL

s
L

-
el

s
ol

-

>
L’_J

L
LJd

¢ [3] 16_XTNewADL_REC1

¢ [3] 16_XTNewADL_REC2
16_XTNewADL_REC3

16_XTNewADL_REC4

& [1] 02_xt3 2_PGM1 (16_XTNewADL_PGM1)
& [1] 02_xt3 2_PGM2 (16_XTNewADL_PGM2)
02_xt3 2_PGM3 (16_XTNewADL_PGM3)

02_xt3 2_PGM4 (16_XTNewADL_PGM4)

In the Tree view you can see all available resources: EVS video servers with their
recorder and player channels, related streams, VTR devices, XF devices.

Description of Icons

All items are preceded by an icon. Additional information, such as gang mode of channels,
is also given by an icon or by text. The meaning of each icon is explained in the following

table.
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Icon | Description

Resolution Information

a high resolution XNet

low resolution XNet

Device Information

EVS video server connected to the XNet. The XT
label is used for any type of EVS video server.
= VTR device connected to the XNet
XF device connected to the XNet
O
Player channel controlled by a ShuttlePRO device
» 02_XT2_PGE_PGM1 (o) Player channel controlled by a BEPlay device.

Player and Recorder Channels

<) Recorder channels
¢ ¢ Brackets around the icon: recorder channel not

associated to a Recorder Panel.

No brackets: recorder channel associated with a
Recorder Panel.

Red icon: recorder channel being recording.
Black icon: recorder channel stopped.

] Player channels

b Brackets around the icon: Player channel with no
associated control, Control Panel or Playlist Panel.

No brackets: Player channel associated with a
Control Panel or a Playlist Panel

Player channel supporting the "Mix on one channel"

functionality.

Channel locked from this workstation

ﬁ Channel locked from another workstation
Streams

- On-line stream (green)

p”

. Recording stream (red)

> -

v Off-line stream (black)

>>
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Icon | Description

’ Scheduled stream (orange)
»

-

p Warning message on the stream (yellow)
»

>

Specific Modes

& ﬁ_‘] Channel ganged with another channel as part of group
3

Channel has been assigned as a PGM

e e R | Channel has been assigned as a PRV

Channel set as a Fill channel in a Fill & Key
association and part of group 2

Channel set as a Key channel in a Fill & Key
association and part of group 2

Player channel locked for use in a Timeline (Timeline
mode)

Channel assigned to a group for use in AB Roll
interface

'\ Note
. high resolution networks appear on top.

If no network is defined in Remote Installer, there will be no XNet root and the
EVS servers will appear as root nodes.

4.2.4. RecorderView

Click the EE button to display the Recorder View:
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Channel Explorer

Tree

D Ree| ~ B piayer

Channel Name
01_XTOIdADL_REC1
01_XTOIdADL_REC2
02_XT2_PGE_REC1
02_XT2_PGE_REC2
12 _XTNewPGE_REC1
12 _XTNewPGE_REC2
12 _XTNewPGE_REC3
12 XTNewPGE_REC4
16_XTNewADL _REC1
16_XTNewADL_REC2
16_XTNewADL_REC3

16_XTNewADL _REC4

HiRes Recorder

01_XTOIdADL_REC1
01_XTOIdADL_REC2

02_XT2_PGE_REC1

®| 02_XT2_PGE_REC?

12_XTNewPGE_REC1
12_XTNewPGE_REC2
12_XTNewPGE_REC3
12_XTNewPGE_REC4
16_XTNewADL_REC1
16_XTNewADL_REC2
16_XTNewADL REC3

16_XTNewADL_REC4

In this view you can see the following items:

hi-res and lo-res recorders

hi-res and lo-res streams

LoRes Recorder

Click the arrow to the right of the button to select which items you want to
display in the Recorder view:

HiRes Recorders

HiRes Streams

LoRes Recorders

LoRes Streams
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Channel Explorer

Tree

'nRec' .

Channel Name

B riayer

HiRes Recorder HiRes Stream LoRes Recorder

4.2.5.

01_XTOIdADL_REC1
01_XTOIJADL_REC2
02_XT2_PGE_REC1
02_XT2_PGE_REC2
12_XTNewPGE_REC1
12_XTNewPGE_REC2
12_XTNewPGE_REC3
12_XTNewPGE_REC4
16_XTNewADL_REC1
16_XTNewADL_REC2
16_XTNewADL_REC3

16_XTNewADL_REC4

Player View
Click the button to display the Player View:

01_XTOIdADL_REC1
01_XTOIdADL_REC2

02_XT2_PGE_REC1

B| 02_XT2_PGE_REC2

12_XTNewPGE_REC1
12_XTNewPGE_REC2
12_XTNewPGE_REC3
12 _XTNewPGE_REC4
16_XTNewADL_REC1
16_XTNewADL_REC2
16_XTNewADL REC3

16_XTNewADL_REC4

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

Stream Hi

4. Channel Explorer
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Channel Explorer

Tree [Qrec v [EPEyery
Channel Name
01_XT2_ADL_PGM1 (01_XTOIdADL_PGM1) Mx
01_XT2_ADL_PGM2 (01_XTOIdADL_PGM2)
01_XT2_ADL_PGM3 (01_XTOIdADL_PGM3)

01_XT2_ADL_PGM4 (01_XTOIdADL_PGM4)

01_xt3 1_PGM1 (12_XTNewPGE_PGM1) &

01_xt3 1_PGM2 (12_XTNewPGE_PGM2)
01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
01_xt3 1_PGM4 (12_XTNewPGE_PGM4)
02_XT2_PGE_PGM1
02_XT2_PGE_PGM2 - Default

02_xt3 2_PGM1 (16_XTNewADL_PGM1)
02_xt3 2_PGM2 (16_XTNewADL_PGM2)
02_xt3 2_PGM3 (16_XTNewADL_PGM3)

02_xt3 2_PGM4 (16_XTNewADL_PGM4)

In this view you can see the following items:

* high resolution players

* low resolution players

Tip
U When auser renames a player channel on an EVS video server, the change is
immediately reflected in the IPDirector interface.

4.2.6. VTR View

This view is only available if a VTR device is connected to the XTNet.
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4.3.

4.3.1.

4.3.2.

Channe! Explorer

Tree [JRec ~

Name

VTR HD Pana

Click the VTR button to activate the VTR View and see the available VTR devices.

From the VTR view, you can lock a VTR device or open a VTR Control Panel by right-
clicking a VTR name and selecting the appropriate option from the contextual menu.

Assigning Channels to IPDirector
Applications

Introduction

From the Channel Explorer, recorder channels can be assigned to Recorder Panels,
player channels can be assigned to a Control Panel or a Playlist Panel, and a default
player channel can be defined. Some of the operating procedures are described below.
Please refer to the manuals related to the modules a channel can be associated with for
more information.

How to Assign a Player Channel to a Control
Panel

There are three ways to assign a player channel to a Control Panel from the Channel
Explorer:

1. Double-click a player in the Channel Explorer: a Control Panel is opened and the
player is automatically assigned toit.

2. Right-click a player channel in the Channel Explorer and select Open Control Panel
from the contextual menu.

3. Open a Control Panel from the main menu, drag a player channel from the Channel
Explorer window and drop it on the open Control Panel.

When a channel is assigned to a Control Panel, the blue brackets around the Player icon

in the Channel Explorer window are removed: D"}l -k
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4.3.3.

How to Define the Default Player for IPDirector

The Default Player setting is used when you open a new application window, such as the
Database Explorer or IPLogger.

111A/01 08:12:04:01

111B/01 08:12:04:01

110A/01 13:49:39:00

No BE Play remote 01_XT2_ADL_PGM2

To define the default player channel, proceed as follows:
1. Inthe Channel Explorer, select the player you wish to define as the default player.

2. Right-click it and select Set as Default Player from the contextual menu.

Channel Explorer

Tree QO Rec v~ | Player
4 [=xr) XT2_ADL
b [#] 01_XT2_ADL_REC1
b [#] 01_XT2_ADL_REC2
(»] 01_XT2_ADL_PGM1
[»] 01_XT2_ADL_PC e
(»] 01_XT2_ADL_P(
[»] 01_XT2_ADL_PC
4 [ XT2_PGE
b [®] 02_XT2_PGE_Ri
b [#] 02_XT2_PGE_Ri
[»] 02_XT2_PGE_PC
[»] 02_XT2_PGE_P(
[»] 02_XT2_PGE_PC
[»] 02_XT2_PGE_P(

Lock

The name of the default player is now displayed in the IPDirector status bar.
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4.4,

4.4.1.

4.4.2.

4.5.

4.5.1.

When the user will open the Database Explorer or the IPLogger, the default player will
automatically assigned to the window.

'\\ Note
. Ifthe default channel is only accessible to the workstation the user is logged
into, the default player assignment may not be accessible when the user moves
to another workstation. This is due to a user rights restriction and is intentional.

Locking Channels

How to Lock a Channel

Right-click a recorder or a player channel and select Lock to prevent other users from
using the channel.

If a channel is locked, it is shown in the Channel Explorer:
channel locked from the current workstation

~
d channel locked from another workstation

How to Unlock a Channel
To unlock a channel: right-click the channel and select Unlock.
If the channel was locked from the local workstation , it will be unlocked immediately.

~
If the channel was locked from another workstation d , you will need to confirm the
Unlock request in a confirmation window.

Starting / Stopping an Ingest

How to Start / Stop a Server Ingest

From the Channel Explorer, you can start and stop the recording of an XT clip.

Two options are available to start the recording of an XT clip.
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Menu Item Meaning

Open Ingest Scheduler | The recording starts and the Ingest Scheduler window
(new ingest) opens.

Start XT Ingest (Tree The recording starts but the Ingest Scheduler window does
View), or not open.

Start Ingest on
Selected Channels
(Recorder View)

In Tree View

To start/stop the recording of an XT clip from the Tree view, proceed as follows:
1. Select the desired recorder(s).
Use SHIFT+click or CTRL+click to select multiple recorders.

2. Right-click and select Start XT Ingest.

Open Recorder Panel

Open Ingest Scheduler (new ingest)

Start XT Ingest

Depending on the settings, the clip is named automatically or the New Schedule
window appears for you to enter a name.

The name of the growing clip is shown in brackets behind the recorder name.

» |®| 02_XT2_PGE_REC1 (recordingingest120614)
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3. To stop the recording, right-click the recorder and select Stop XT Ingest.

In Recorder View

To start/stop the recording of an XT clip from the Rec View, proceed as follows:

1.

Select the desired recorder(s).

Use SHIFT+click or CTRL+click to select multiple recorders.

2. Right-click and select Start Ingest on Selected Channels.

01 XT2 ADL F - 01XT2

Open Recorder Panel

| 01_XT2
01 XTZ ADLF |®] & Open Ingest Scheduler (new ingest)

02_XT2_PGE_F |[®| 02 XT2 .
Start Ingest on Selected Channels
02_XT2_PGE_F |®] 02_XT2
Lock

OR

Click the Record Now button [l

Depending on the settings, the clip is named automatically or the New Schedule
window appears for you to enter a name.

To stop the recording, click the Stop Recording button on the right of the red
Recording button:

4.5.2. How to Start, Stop or Kill a Stream

From the Channel Explorer, you can start and stop the recording of a file from a stream.

To start/stop a stream, proceed as follows:

1.

Right-click a stream in the Tree view.
A contextual menu is displayed.
Select the desired option.

The available options for starting streams (and ingests) depend on the selected
stream (Hi or Lo).

4. Channel Explorer
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Hi-res Stream

Open Ingest Scheduler (new ingest)

Start Hires Stream

Lo-res Stream
Open Ingest Scheduler {new ingest)

Start LoRes and HiRes stream

Start Lores stream and XT Ingest

Depending on the settings, the resulting file is named automatically or the New
Schedule window appears for you to enter a name.

3. Once a stream is running, it can be stopped or killed from the Channel Explorer as
well. Right-click the stream and select the desired option:

Stop Stream

Kill Stream

4.6. Channels Associations

4.6.1. How to Gang Recorder or Player Channels

When channels are ganged, they can be controlled simultaneously from the same
interface: the ganged Control Panel. It can be opened by double-clicking one of the
ganged channels. See the Control Panel user manual for more information.

Note
« Itis not possible to gang recorder channels with player channels.

To gang 2 or more channels, proceed as follows:
1. Select the channels with SHIFT+click or CTRL+click.

2. Right-click one of the channels and select Gang.
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Channel Explorer

Tree || [OQrec v | Player
f% 01_XTOIdADL
5] 02_XT2_PGE

{7 12_XTNewPGE
b [#] 12_XTNewPGE_REC1
| 12_XTNewPGE_REC2
[#] 12_XTNewPGE_REC3
| 12_XTNewPGE_REC4
| 01_xt3 1_PGM1 (12_XTNewPGE_PGM1)

01_xt3 1_PGM2 (12_XTNewPGE_PGM2) - Default
| 01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
| 01_xt3 1_PGM4 (12_XTNewPGE_PGM4) Open Control Panel

» =7 16_XTNewADL
Lock

Gang

Pgm/Prv
Fill Key

Lock Timeline

AB Roll Playlist

press +
3. The ganged channels will have an & icon next to them to signify their new status.

Channel Explorer

BN OQrec v B Player
p & 01_XTOMADL
» [ 02_XT2_PGE
4 [ 12_XTNewPGE
b [#] 12_XTNewPGE_REC1
b [#] 12_XTNewPGE_REC2

» [®] 12_XTNewPGE_REC3
b [#] 12_XTNewPGE_REC4
[»] 01_xt3 1_PGM1 (12_XTNewPGE_PGM1)
» 01_xit3 1_PGM2 (12_XTNewPGE_PGM2) - Default
|»| ¢ [1] 01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
|»| ¢ [1] 01_xt3 1_PGM4 (12_XTNewPGE_PGM4)
p =] 16_XTNewADL
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4. Toadd more channels to a group: select all channels of the group and the new
channel, right-click and select Gang again.

You can have many different ganged channel groups with a number of channels per group,
performing different tasks on a production.

Each of the linking icons will have a number next to it in the Channel Explorer to indicate
which group the channel belongs to.

Channel Explorer

W u Rec ¥ u Player
p =1 01_XTOMADL
» e 02_XT2_PGE
4 =7 12_XTNewPGE
b [ ® [2] 12_XTNewPGE_REC1
b [*| & [2] 12_XTNewPGE_REC2

b |#] 12_XTNewPGE_REC3
» |®| 12 XTNewPGE_REC4
[»] 01_xt3 1_PGM1 (12_XTNewPGE_PGM1)
» 01_xi3 1_PGM2 (12_XTNewPGE_PGM2) - Default
[»| & [1] 01_xt3 1_PGM3 (12_XTNewPGE_PGM3)
L] & [1] 01_xt3 1_PGM4 (12_XTNewPGE_PGM4)
p =] 16_XTNewADL

4.6.2. How to Ungang Ganged Channels

To ungang ganged channels, would they be in Gang mode, PGM/PRV mode, Fill&Key
mode, Lock Timeline mode or AB Roll mode, proceed as follows:

1. Select the ganged channels with SHIFT+click or CTRL+click.
2. Right-click one of the channels
A contextual menu is displayed.

3. Select Ungang.

Note

. Channels can be selected even if they are part of different ganged groups. Each
selected channel will be removed from the ganged group of channels it was part
of.

4.6.3. How to Associate Player Channels in
PGM/PRV Mode

At least 2 player channels must be available to define this association.
To associate channels in PGM/PRV mode, proceed as follows:
1. Select two channels with SHIFT+click or CTRL+click.
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2. Right-click one of the selected channels
3. Select Pgm/Prv.

Channel Explorer

Tree OQrec v | Player
4 [%r) XT2_ADL
| 01_XT2_ADL_REC1
[#] 01_XT2_ADL_REC2
| 01_XT2_ADL_PGM1
01_XT2_ADL_PGM2
Open Control Panel

| 01_XT2_ADL_PGM3

[»]| 01_XT2_ADL_PGM4 (PGM Lock

k‘
Q
Q|
m

_XT2_PGE_REC1

_XT2_PGE_REC2

_XT2_PGE_PGM1

_XT2_PGE_PGM2 Pam/Prv
_XT2_PGE_PGM3

_XT2_PGE_PGM4 ()

QQ

[=}

Fill Key

2
2
2
02
2
2

L
[=]

Lock Timeline

AB Roll Playlist

4. The channels are now shown with the PGM and PRV annotations.

|»| 01_XT2_ADL_PGM1 FGl1
|»| 01_XT2_ADL_PGM2 PRy

Note

« You can only make a PGM/PRYV pair of PGM1-PGM2 or PGM3-PGM4 on any
EVS server. PGM1 or PGM3 are always the PGM channels and PGM2 or PGM4
will always be the PRV channels.

4.6.4. How to Associate Player or Recorder
Channels in Fill & Key Mode

Channels of the EVS servers can be ganged in a specific style called Fill & Key. This
mode manages assignments of clips or playlists, and forces them to recall to the
appropriate channels, so as to allow you to perform synchronized clip or playlist recalls in
a Fill & Key scenario (sometimes called Matte & Fill).

To associate channels in Fill & Key mode, proceed as follows:
1. Select two channels with SHIFT+click or CTRL+click.

2. Right-click one of the selected channels

3. SelectFill Key.
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Channel Explorer

Tree QOQRrec v B Player
4 [ XT2_ADL
b [#] 01_XT2_ADL_REC1
b [#] 01_XT2_ADL_REC2
[»] 01_XT2_ADL_PGM1
» 01_XT2 ADL PGM2
(»] 01_XT2_ADL_PGM3
[»] 01_XT2_ADL_PGM4 (F 152
4 =7 XT2_PGE
b [®] 02_XT2_PGE_REC1

Open Control Panel

b [®] 02_XT2_PGE_REC2
[»] 02_XT2_PGE_PGM1
[»] 02_XT2_PGE_PGM2
[»] 02_XT2_PGE_PGM3
[»| 02_XT2_PGE_PGM4 ()

Pgm/Prv
Fill Key

Lock Timeline

AB Roll Playlist

press +

4. The channels are now shown with the Fillo and Keyo icons:
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Channel Explorer

H Tree Qrec v | Player
4 [xr) XT2_ADL
b [#] 01_XT2_ADL_REC1

» [®] 01_XT2_ADL REC2
» ¢ [1]01_XT2_ADL_PGM1
» x [1]01_XT2_ADL_PGM2
[»] 01_XT2_ADL_PGM3
| »| 01_XT2_ADL_PGM4 (PGM4)

4 %) XT2_PGE
» @] 02_XT2_PGE_REC1
b [®] 02_XT2_PGE_REC2
[»] 02_XT2_PGE_PGM1
[»] 02_XT2_PGE_PGM2
[»] 02_XT2_PGE_PGM3
[»] 02_XT2_PGE_PGM4 ()

The association will also be reflected in the title bar of the Control panels.

Note
« Thefirst channel you select will become the Fill and the second one the Key.

4.6.5. How to Lock Player Channels for Timeline
Mode

The IPEdit module requires two player channels to function. This pair of player channels is
called the Timeline Engine. The Timeline Engine can be PGM1/PGM2 or PGM3/PGM4

When two player channels are assigned to IPEdit, the Lock Timeline mode is
automatically activated. This prevents you and other users from using these player
channels in another mode than the Timeline mode.

See the IPEdit user manual for more details about this feature.

The Timeline Lock is visible in the Channel Explorer: the Timeline Lock icon is
displayed in front of these channels:
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Channel Explorer

”'Tree - QO Rrec v | Player
4 =] XT2_ADL
b [#] 01_XT2_ADL_REC1

» [#] 01_XT2_ADL_REC2
[»] 01_XT2_ADL_PGM1
» 01_XT2_ADL_PGM2
2| [»] 01_XT2_ADL_PGM3
2| [»] 01_XT2_ADL_PGM4 (PGM4)

The Timeline Lock can be activated from the Channel Explorer. To do so, proceed as
follows:

1. Select two channels with SHIFT+click or CTRL+click.
2. Right-click a channel.

3. Select Lock Timeline.

Note

. The Lock Timeline mode is not automatically deactivated when the user leaves
IPEdit. It needs to be deactivated manually in the Channel Explorer.

4.6.6. Defining a Channel Group for the AB Roll
Playlist

The AB Roll Playlist can be associated to 2, 3 or 4 channels. Before you can use the AB
Roll Playlist you need to define this channel group in the Channel Explorer.

To define a channel group, proceed as follows:
1. Open the Channel Explorer and browse to the desired channels.

2. Select the channels that need to be associated to the AB Roll Playlist application.

Channel Explorer vy - OX

IBBieEY Qrec v | Player
p v XT2_ADL
4 =7 XT2_PGE
4 |®] 02_XT2_PGE_REC1
»» Stream Hi

4 [®] 02_XT2_PGE_REC2
»» Stream Hi
|»| 02_XT2_PGE_PGM1
|»| 02_XT2_PGE_PGM2
|»| 02_XT2_PGE_PGM3
|»| 02_XT2_PGE_PGM4 ()
~ XFile
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3. Right-click the selected channel group
4. Select AB Roll Playlist from the contextual menu.

5. The Configure AB Roll Playlist channel association window opens:

Configure AB Roll Playlist channel association

You can assign different letters to the channels by modifying the letter of the first channel.

CH Associated server channel
02_XT2_PGE_PGM1 02_XT2_PGE_PGM1
02_XT2_PGE_PGM2 02_XT2_PGE_PGM2
02_XT2_PGE_PGM3 02_XT2_PGE_PGM3

02_XT2_PGE_PGM4

6. Inthis window you can edit the channel letters in the left column of the table, if so
desired.

7. Click OK to accept the presented allocation.
The selected channels are now marked with the "Ganged" icon and ready to be used
as an AB Roll Playlist channel group:

Channel Explorer vy - O X

QO Rec v | Player
b [ XT2_ADL
4 [x7] XT2_PGE
4 [®] 02_XT2_PGE_REC1
Stream Hi

|®| 02_XT2_PGE_REC2
Stream Hi
AB |»| 02_XT2_PGE_PGM1
AB |»| 02_XT2_PGE_PGM2
AB |»| 02_XT2_PGE_PGM3
AB |»| 02_XT2_PGE_PGM4 ()
~ XFile
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4.7.

4.8.

4.8.1.

Displaying Information on the OSD

The information to display on screen is set in the OSD Settings window. See section
"OSD Settings" on page 42.

To turn the OSD ON or OFF from the Channel Explorer, proceed as follows:

1. From the Tree view or the Player view, right-click the player channel for which you
want to display the OSD information.

A contextual menu appears.
2. Select OSD Information on Monitor.
The information is displayed on screen.

3. To hide the information, repeat steps 1 and 2.

Operations on Servers

How to Get Server Monitoring Information

From the Channel Explorer, it is possible to check the EVS server monitoring information.
To do so, proceed as follows:

1. Right-click a server name in the Channel Explorer.
2. Select Show Server Monitoring Information from the contextual menu.

The [Server Name] Information window opens:
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XT2_ADL Information

Status Monitoring

Genlock Ko BgTask average

Disk Problem BgTask on last 100 It
SDTI Connection error IRQ Divergence to pCode
SDTI Corruption (Used Clip FiFo) Out of IRQ

SDTI Corruption (Notify Lost) Command SDTI Time Out

DB Corrupted (Local Clips) Broadcast SDTI Time Out

DB Corrupted (Index Mismatch) SDTI Light Traffic

SDTI Heavy Traffic

Auto Refresh

ItTask monitoring

Delta Average Delta Worst
Start ItTask Send Command 70 87
Start ItTask Control Manager 2

End ItTask Send Command 2

4.8.2. How to Launch a Different Predefined Server
Configuration

It is possible to launch another predefined server configuration provided that you have the
appropriate user right.

To do so, proceed as follows:
1. Right-click a server name in the Channel Explorer.
2. Select Restart Server from the contextual menu.

The Server Configuration window opens:
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Server Configuration

XT2ADL

Application List Application Parameters

Config number 00
01 LSM 4REC 2PLAY Config name SPOTBOX IPDP 2RE
02 LSM 1REC 2PLAY Codec type N/A
03 LSM 2REC 2PLAY Bit rate 30 mBits/sec
04 LSM 2REC 4PLAY Recorders 2
05 LSM 3REC 1PLAY Players 4
06 LSM 3REC 2PLAY MonofChannel
07 LSM 3REC 3PLAY Video resolution N/A
08 LSM 4REC 2PLAY Aspect ratio 16/9
Video standard NfA
10 SLSM  1PLAY Audio format  Embedded
11 5LSM  2PLAY Audio/Channel 8 tracks
12 SLSM+1REC 2PLAY Audio status  Audio on
13 SLSM+2REC 1PLAY

[y
&

Select and Restart Server Cancel

On the left, the Application List displays the list of applications available on the
selected server and sorted in the same order as in the EVS menu.

The application currently launched in Multicam is displayed in red.

On the right, the parameters corresponding to the selected configuration are
displayed.

3. (optional) If you want to select another server, right-click the Server Name field and
choose a server:

4. Select another configuration from the Application List.
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5.

The corresponding parameters are displayed in the Application parameters pane. The

background button turns blue.

15 SPOTBOX

Click the Select and Restart Server button to apply the new configuration.

4.8.3. Multicam Web Setup Tool

M Itis possible to access the Multicam Web Setup Tool from IPDirector.

To do so, proceed as follows:

1.
2.

Right-click a server name in the Channel Explorer.
Select Configure Server from the contextual menu.
The Multicam Web Setup window opens.

See the Multicam manual for more information.

4.9. Channel Explorer Shortcuts

Some commands in the Channel Explorer can be accessed from the keyboard.

To view or customize the keyboard shortcuts, proceed as follows:

1.

2.

3.

4.
5.

Click Tools > Define Shortcuts in the main IPDirector toolbar.

This opens the Define Shortcuts window.

Click the Channel Explorer button on the left to go to the relevant section:

General

Channel Mgmt

Channel Explorer

Control Panel

Database Explorer

You can view the available shortcuts here.

Description Current Value
Gang/Ungang selected channels

Associate channels in FILL & KEY mode

Associate channels in PGM/PRV mode

Lock{/Unlock selected channels

To change a shortcut: select it and press the desired key combination.

Click OK to save your changes.

4. Channel Explorer
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5. On-Screen Display

5.1.  Configuration and Activation

each playout channel. This does not apply to recorder channels or software player. See

M The information to display on a monitor is set in the OSD Settings window. It is defined for
section "OSD Settings" on page 42.

The OSD can be turned ON or OFF in several ways:

* By using a shortcut in the various IPDirector applications: Control Panel Playlist
Panel, AB Roll Playlist Panel, IPEdit, IPLogger, Database Explorer. See sections
"Channel Management Shortcuts" on page 49 and "Channel Management Shortcuts"
on page 49.

» By using a shortcut on the ShuttlePRO. See section "ShuttlePRO Configuration" on
page 98.

* By selecting an option in the Channel Explorer. See section "Displaying Information
on the OSD" on page 124.

5.2. Impacted Channels

Depending on the channel mode the player channel is involved into, the effect of the Turn
OSD ON or OFF shortcut will differ as detailed in the table below.

If the channel
mode is...

.-the OSD appears / disappears for...

PGM the player channel linked to the device or active panel from which
the shortcut has been applied

PGM/PRV * In Clip mode (clip, growing clip, train loaded):

the player channel linked to the device or active panel from
which the shortcut has been applied

* InPlaylist mode (playlist loaded):
both player channels engaged in PGM/PRV mode

Fill & Key the player channel linked to the device or active panel from which
the shortcut has been applied

Ganged the player channel linked to the device or active panel from which
the shortcut has been applied

IPEdit (Timeline | the player channel associated to the panel which is active in IPEdit:
mode) Player or Timeline

AB Roll all the player channels associated to the AB Roll Panel
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